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About DMTI Spatial  
 
 DMTI Spatial™ Inc. is Canada’s leading Location Intelligence provider.  We enable users to understand 
their customers, optimize resources, realize opportunities, maximize profitability and make more informed 
decisions through accurate products and innovative thinking. 
 
DMTI Spatial publishes precision built street map, rail and routing data (CanMap®), a detailed water layer, 
and innovative geocoding and address management software (GeoPinpoint™).  In addition, DMTI Spatial 
publishes a full range of positionally accurate geospatial data products including: enhanced points of 
interest (EPOI), census data and boundaries, postal geography, topographic maps, and US mapping 
data.  As part of a complete business geographic solution, DMTI Spatial™ offers a wide range of GIS 
services, consulting, and software training. 
  
Established in 1994, DMTI Spatial is committed to setting the standard within the GIS industry for 
precision built geo-spatial data and address management services. 
 
At DMTI Spatial, we believe that our true strength comes from working closely with our customers and 
providing innovative solutions to meet their strategic business objectives.  As Canada’s premier spatial 
solutions provider we pride ourselves with having worked with North America’s leading organizations to 
support their mission critical applications.  
 
DMTI Spatial works with large and small organizations representative of a wide variety of industries:   
 
• Agriculture • Forestry • Mining 
• Banking/Finance • Government • Real Estate 
• Consulting • Health • Retail 
• Education • High Technology • Telecommunications 
• Emergency Services • Insurance • Transportation 
• Engineering • Manufacturing • Utilities  
• Environmental • Media  
 
We are a member of the ESRI Canada Business Partner Program, and winner of the 2001 ESRI 
Worldwide New Business Partner of the Year Award and the 2005 ESRI Foundation Partner of the Year 
Award. We are a strategic business partner of MapInfo and winner of the Markham Board of Trade 2000 
Award for Entrepreneurship and Innovation.  Recipient of The Association of Canadian Map Libraries and 
Archives (ACMLA) 2002 Certificate of Appreciation. 
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Really Smart Spatial Solutions™ 
 
Through the application of its products and services, DMTI Spatial™ has been involved with projects such 
as: location-based services, logistics planning, emergency dispatch, facilities management, data 
management, customer care, address management, land base development in support of network 
planning, and marketing/demographic analysis applications. 
 
DMTI Spatial™ can provide all of the components necessary for the acquisition, implementation, 
operation and maintenance of a successful GIS system within companies of all sizes.   Through its 
product and service offering, DMTI Spatial™ can provide users with 5 key components: 
 
1. Accurate, detailed, and compatible data 
2. Comprehensive maintenance program 
3. GIS software  

4. Consulting and services 
5. Software training 

 
DMTI Spatial™ Product & Service Portfolio
 
DMTI Spatial’s product & service offering 
includes: 

 
CanMap® - Digital Map Data for Canada 
• CanMap® Streetfiles  
• CanMap® RouteLogistics 
• CanMap® Rail 
• CanMap® Major Roads and Highways 
• CanMap® Parks & Recreation 
• CanMap® Water 
 
Satellite Imagery  
• Satellite StreetView™ 
 
Municipal Amalgamations 
• CanMap® Municipality Amalgamation File 

(MAF) 
 
Business & Recreational Points of Interest 
• Enhanced Points Of Interest (EPOI)  
 
GeoPinpoint™ Suite   
• Canada’s Geocoding Solution 
• Modular Architecture  
• Windows Standalone Desktop Version 
• UNIX, Java Wrapper, ActiveX (DLL Version)   
 
Topographic Data and Base Maps 
• Canadian Atlas Map Bundle (CAMB) 
• Populated Placenames  
• National Topographic Data Base (NTDB) 
• 30 & 90m Digital Elevation Models (DEM) 
• Clutter Data  
 
Postal Geography & Data  
• Six-Digit Postal Code File (LDU Points)  
• Six-Digit Postal Code File (LDU Boundary) 
• Enhanced Postal Code File (MEP) 

• Forward Sortation Areas (FSA) Boundary File 
 
 
 
 
 
1996 Census Boundaries & Demographic Data 
• Enumeration Area (EA) 
• Census Subdivision (CSD) 
• Census Division (CD) 
• Census Metropolitan Area/Census 

       Agglomeration (CMA/CA) 
• Census Tract (CT) 
• Federal Electoral Districts (FED) 
 
2001/6 Census Boundaries 
• Dissemination Area (DA) 
• Census Subdivision (CSD) 
• Census Division (CD) 
• Census Metropolitan Area/Census 

       Agglomeration (CMA/CA) 
• Census Tract (CT) 
• Federal Electoral Districts (FED) 
 
GIS Software  
• Contour Modeling and Display 
• Demographic Profiling and Lifestyle Targeting 
• Geocoding and Mapping Software 
• Routing and Logistics 
 
Consulting and Services 
• Address Management Solutions 
• Application Development 
• Database Marketing 
• Data Conversion and Creation 
• Database Scrubbing 
• Geocoding Services  
• GIS Consulting 
• Technical Support 
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Technical Support, Error Reporting & Product Enhancement Services 
 
DMTI Spatial is committed to building the best products possible for our customers.  By using our data every 
day in your mission critical application you are our best source for product refinement.  Please let us know if 
you have an enhancement request or found an error in any of our products so that we can make the 
correction for the next release. 
 
This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.  Please 
be as specific as possible so that we can improve our products quickly and accurately.  To submit an error or 
request technical assistance please visit: http://www.dmtispatial.com/support/
 
If you have an idea for a new product, or an enhancement request for an existing product, please visit our 
product manger’s desk on the web at: http://www.dmtispatial.com/pm/
or e-mail: pm@dmtispatial.com
 
Contact Information 
 
DMTI Spatial Inc. 
625 Cochrane Drive, 3rd Floor 
Markham, Ontario 
L3R 9R9 Canada 
 
Telephone: 905-948-2000 
Toll Free: 1-877-477-DMTI (3684) 
Fax: 905-948-9404 
 
Web Site: www.dmtispatial.com
Error Reporting Service: http://www.dmtispatial.com/helpdesk/index.aspx
Product Enhancement Requests: pm@dmtispatial.com
Technical Support: http://www.dmtispatial.com/helpdesk/index.aspx
 
Trademarks and Notices 
 
© 2008 DMTI Spatial Inc. CanMap is a registered trademark of DMTI Spatial Inc. DMTI Spatial, Really Smart 
Spatial Solutions, Because Where Is What Matters and GeoPinpoint are trademarks of DMTI Spatial Inc.  All 
rights reserved.  Other products and company names mentioned herein may be trademarks of their 
respective companies.  Mention of third-party products is for informational purposes only and constitutes 
neither a recommendation nor an endorsement. 
 
DMTI Spatial is an Authorized User and Distributor of selected Statistics Canada Computer File(s) under 
Licensing Agreement 6228.  No confidential information about an individual, family, household, organization 
or business has been obtained from Statistics Canada. 
 
© Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of 
Industry, Statistics Canada 2007. 
 
Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with 
permission of Natural Resources Canada and The Queen in Right of Manitoba. 
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About EPOI v2008.3 
 
File Properties 
 
Property Description 
Coverage Nationwide 
Currency May 15, 2008 
Format ASCII text files (comma delimited)1

 
File Naming Conventions 
 
Representing the data coverage, files are either named by a region, Statistics Canada census subdivision 
(CSD) number, or a Standard Industrial Classification.   
 
File Names by Region 
 
For example: \On.txt 
 
 

Geographic Area Abbreviation2

ON 
 
File Names by 1996 Census Subdivision (CSD) 
 
Census Subdivision is the general term applied to municipalities (as determined by provincial legislation) 
or their equivalent, for example Indian reserves, Indian settlements and unorganized territories. 
 
All files are prefixed with the Census Subdivision Code.  An additional text file (CSD.txt) containing a CSD 
and its associated municipality name is included in each order by CSD. 
 
For example: \3520004_A.txt 
 
 

Census Subdivision File Name 
3520004 (Toronto) A (Division A) 

 
File Names by Standard Industrial Classification (SIC) 
 
Orders by SIC will contain the SIC specification of the data purchased in the file name.3

 
For example: \OnA.txt 
 
 

Geographic Area Abbreviation File Name 
ON A (SIC Division A) 

 
 

                                                 
1 See Appendix A: Importing Data Into GIS Software for information on how to import EPOI files into GIS software (including 
MapInfo, ArcView 3.x, and ArcGIS 8.1). 
2 See Appendix B: Provincial and Territorial Abbreviations and Codes and Appendix C: Canadian Urban Areas and Abbreviations for 
a list of region names and their abbreviations. 
3 For a list of File Name abbreviations, refer to Appendix D: Standard Classification (SIC) Codes. 

 DMTI Spatial Inc. 625 Cochrane Dr., 3rd Floor, Markham, Ontario, Canada, L3R 9R9      
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File Names of EPOI Look Up Tables 
 
Look up tables contain information such as; the number of beds in a hospital, the location code of an 
airport, and the grade range taught within a school. Look up tables are linked to the main table via the 
POI_ID field.  For example, a record in the POI database that has an EPOI_TYPE = POL (Police 
Services) links via the POI_ID field to the “pol”  (Police Services) look up table. 
 
EPOI and EPOI Look Up Table Examples 
 
EPOI File EPOI Look Up Table Description 
OnJ.TXT OnJ_POL.txt Ontario by SIC Division “J” (Public Administration) 
On92.txt On92_POL.txt Ontario by SIC Major Group “92” (Justice, Public Order, And 

Safety) 
On9221.txt On9221_POL.txt Ontario by SIC Code “9221” (Police Protection) 

 
Enhanced attribution can be found in the following look up tables.   
 
EPOI_TYPE 
Classification  

EPOI_TYPE Description 

ACC Accommodation 
AER Aerodromes 
BLD Building Names 
BOR Border Crossings & Customs Offices 
CAR Car Rental Agencies 
CIN Cinemas 
CPL Car Pool Parking Lots 
EDU Education 
FIN Financial Institutions 
FRE Fire Stations 
GAS Gasoline Service Stations 
GLF Golf Courses 
HCR Health Care 
POL Police Services 
RPO Retail Postal Outlets 
SHP Shopping Centres 
SKI Ski Centres 
TOL Toll Booths 
TOU Tourist 
TRS Transit Stops 
WGH Weigh Stations 
 
EPOI File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID 
NAME Character 150 Name 
UNIT_SUITE Character 25 Unit or Suite # 
ADDRESS Character 45 Address 
DELIV_MODE Character 25 General Delivery Address (i.e. PO BOX) 
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CITY Character 68 City or Municipality  
PROV Character 2 Province 
POST_CODE Character 7 Postal Code 
LOCATION Character 100 Description of location 
PHONE Character 15 Phone Number 
FAX Character 15 Fax Number 
TOLL_FREE Character 15 Toll Free Number 
EPOI_TYPE Character 3 Three letter abbreviation of EPOI type 
CAF Character 15 Common Address Flag 
SIC_1 Character 8 Standard Industrial Classification - Primary 
SIC_2 Character 8 Standard Industrial Classification 
SIC_3 Character 8 Standard Industrial Classification 
SIC_4 Character 8 Standard Industrial Classification 
SIC_5 Character 8 Standard Industrial Classification 
SIC_6 Character 8 Standard Industrial Classification 
SIC_MJ_GRP Character 2 Standard Industrial Classification Major Group 
SIC_DIV Character 1 Standard Industrial Classification Division Group 
X Number  Longitude 
Y Number  Latitude 
PREC_CODE Character 2 Precision code indicating accuracy of geocoded point 
ATTRIBCODE Character 2 Attribution code indicating the accuracy of attribute data
 
Common Address Flag (CAF) 
 
It is common for businesses or other recreational facilities to share addresses, for example in skyscrapers 
or shopping centers.  The EPOI product has a feature that allows users to identify records that have 
common addresses.  A group by query on the CAF field will allow a user to extract a single record by 
address.  The CAF is an alphanumeric code that is unique to a unique address.   
 

NAME ADDRESS SIC PHONE CAF 
Business 1 10 Main St. A 1 ADD1 
Business 2 10 Main St. B 2 ADD1 
Business 3 10 Main St. C 3 ADD1 
Business 4 1 King St. D 4 ADD2 
Business 5 1 King St. E 5 ADD2 

 
The CAF is only applied to records that have an address. Some DMTI-sourced records (AttribCode = “1”) 
do not have an address and therefore the CAF field is blank. 
Precision Code (PREC_CODE) 
 
Value Description 
1 Centroid of 1:50 000 NTDB feature or placed via Orthorectified photo 
2 Block-face representative point from CanMap streets - High precision 
3 Block-face representative point from CanMap streets - Lower precision 
4 Postal Code - Block-face representative point/ Local Delivery Unit (LDU) centroid 
5 Forward Sortation Area (FSA) centroid 
6 Municipal Centroid 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
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Attribution Code (ATTRIBCODE) 
 
Value Description 
1 DMTI Spatial sourcing 
2 Other sourcing – High confidence (Validated by DMTI Spatial) 
3 Out of Business Record 

 
EPOI Look Up Table Specifications 
 
Look Up Tables link to the main database via EPOI_TYPE and POI_ID for enhanced attribution.  
Enhanced attribution can be found in the following look up tables.   
 
EPOI_TYPE 
Classification  

EPOI_TYPE Description 

ACC Accommodation 
AER Aerodromes 
BLD Building Names 
BOR Border Crossings & Customs Offices 
CAR Car Rental Agencies 
CIN Cinemas 
CPL Car Pool Parking Lots 
EDU Education 
FIN Financial Institutions 
FRE Fire Stations 
GAS Gasoline Service Stations 
GLF Golf Courses 
HCR Health Care 
POL Police Services 
TOL Toll Booths 
TOU Tourist 
TRS Transit Stops 
WGH Weigh Stations 
 
 
SIC Look Up Tables link to the main database via SIC Division or SIC Major Group.   
 
Look Up Table Look Up Table Description 
sic_mjgrp_desc SIC Major Group Descriptions 
sic_div_desc SIC Division Descriptions 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
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SIC Division Descriptions (sic_div_desc) 
 
The SIC Division Description table includes the description of all SIC Divisions that exist in the file. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
SIC_DIV Character 1 SIC Division Group 
DESCRIPTION Character 150 Description of SIC Division 
 
 
SIC Major Group Descriptions (sic_mjgrp_desc) 
 
The SIC Major Group Description table includes the description of all SIC Major Groups that exist in the 
file. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
SIC_MJ_GRP Character 2 SIC Major Group 
DESCRIPTION Character 150 Description of SIC Major Group 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
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 Data Dictionary 
 

Accommodation (acc) 
 
The accommodation layer includes hotels, motels, and inns.   
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main POI database) 
EPOI_TYPE Character 3 Point of Interest Classification  
CHAIN Character 100 Accommodation Chain 
 
Aerodromes (aer) 
 
The aerodromes layer includes airports, heliports, and water aerodromes.4

 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
ICAO_CODE Character 4 Location Indicator assigned by Transport Canada and the 

U.S. Federal Aviation Administration (4 character) 
IATA_CODE Character 3 Location indicator assigned by Transport Canada and the 

U.S. Federal Aviation Administration (3 character) 
AER_TYPE Character 10 Type of Aerodrome  
STATUS Character 10 Operational Status of Aerodrome.  Indicates if the 

aerodrome is operational or abandoned. 
NAME_ALIAS Character 125 Alternate name of Aerodrome 
X1 Number  Longitude of first or main entrance point (Terminal 1) 
Y1 Number  Latitude of first or main entrance point (Terminal 1) 
X2 Number  Longitude of second entrance point (Terminal 2) 
Y2 Number  Latitude of second entrance point (Terminal 2) 
X3 Number  Longitude of third entrance point (Terminal 3) 
Y3 Number  Latitude of third entrance point (Terminal 3) 
 
Contents 
 
AER_TYPE Description 
LAND Aerodromes that provide an advantage for the aviation community are included. This 

includes aerodromes that are open to the public, are used by more than one aircraft 
and have a telephone available for users of the aerodrome. 

WATER Water aerodromes that provide an advantage for the aviation community are 
included, typically this includes aerodromes that are open to the public, are used by 
more than one aircraft, have an area for docking or beaching with tie downs and have 
a telephone available for users of the aerodrome. 

HELIPORT Heliports that provide an advantage for the aviation community are included. This 
includes heliports that are open to the public, are used by more than one aircraft and 

                                                 
4 Source: Geomatics Canada, Canada Flight Supplement and Canada Water Aerodrome Supplement (WAS), March 2003 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
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have a telephone available for users of the heliport. 
 
Name and Name_Alias 
 
The Name field contains the names of aerodromes and indicates what communities they may serve.  The 
Name_Alias field provides an alias for the aerodrome.  For example: 
 
Name City Name Alias 
Toronto/Lester B. Pearson Intl Toronto Lester B Pearson International Airport 
Montréal/St-Hubert Montréal Aeroport de Saint-Hubert 
Calgary/Springbank Calgary Calgary Springbank Airport 
 
Building Names (bld) 
 
The Building Names layer includes building names and building types. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
SUITE_FROM_NUM Character 25 The lowest value in a range of suites or apartments 
SUITE_TO_NUM Character 25 The highest value in a range of suites or apartments 

BUILD_TYPE Character 11 Representation of whether the building is a business 
building or an apartment building 

 
 
Border Crossings & Customs Offices (bor) 
 
The Borders Crossings and Customs Offices layer includes independent offices, subordinate offices, 
service sites, and warehouses.  
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 

BOR_TYPE Character 10 Indicates if a port is an Independent, a Subordinate or a 
Service Site 

PORT_NO Character 5 The number of the Independent Port 

REP_TO Character 35 The name and number of the Independent Port that a 
Subordinate or Service site reports to 

HUB Character 1 
Indicates if a port is a HUB or not.  A HUB is an 
independent office to which a subordinate office would 
report. 

SERVICES Character 45 Types of services available at that port5

US_PORT Character 30 Name of the US Customs Office opposite to the Canadian 
Customs Office 

                                                 
5 Detailed information regarding customs operations, the hours and types of services available at custom offices, definitions of 
terms, and abbreviations used in the Services field, can be found in Appendix E: Border Crossings and Customs Offices.   
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Contents 
 
BOR_TYPE Description 
IND Independent Offices 
SER Service Sites 
SUB Subordinate Offices 

 
Car Rental Agencies (car) 
 
The Car Rental Agencies layer includes the following Car Rental Agencies: Alamo, Avis, Budget, 
Discount, Enterprise, Hertz, National and Thrifty. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
CHAIN Character 100 Car Rental Chain 
LOC_CODE Character 10 Unique Identifier for a branch within a chain 
 
Cinemas (cin) 
 
The cinema layer contains cinemas across Canada. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
SCREEN_NO Character 5 Number of screens in given theatre 
PHONE_2 Character 15 Second phone number 
 
 
Car Pool Parking Lots (cpl)  
 
The Car Pool Parking Lots layer indicates the name, exit number, and location of Car Pool Parking Lots 
on the Major Expressways.  This layer provides data for Ontario only. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
EXIT_NUM Character 5 Hwy exit number at location of Car Pool Lot 
DIRECTION Character 2 Direction of Hwy Car Pool Lot  
 
 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
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Education (edu) 
 
The Education layer includes Elementary Schools, High Schools, Colleges, Cégeps and Universities.  
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
EDU_TYPE Character 10 Education Point of Interest Classification 
DISTRICT Character 100 District where the facility resides 
LEVEL Character 10 Teaching Level 
LANGUAGE Character 10 Predominate or language-only type Some educational 

facilities use two languages to teach, but one is usually 
predominant.  The dominant language is represented first.

GRADES  Character 10 Grade range 
  
Contents 
 
EDU_TYPE Description 
CG Cégep 
CL College 
FN First Nations 
P   Public 
PR Private/Independent 
S Catholic (Separate) 
SN Special Needs 
UV University 
 
LANGUAGE Description 
E English 
F French 
H Hebrew 
G German 
U Ukrainian 
C Cree 
F/E French & English 
E/F English & French 
E/H English & Hebrew 
E/G English & German 
E/U English & Ukrainian 
 
LEVEL GRADES Description 
J K-6 Junior 
I 7-8 Intermediate 
S 9-12 Senior 
J/I K-8 Junior/Intermediate 
I/S 7-12 Intermediate/Senior 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
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J/I/S K-12 Junior/Intermediate/Senior 
 
Financial Institutions (fin) 
 
The Financial Institutions layer includes financial institutions belonging to one of the following three 
groups: (1) Banks, (2) Credit Unions and Caisses Populaires, (3) Trust Companies, Loan Companies, and 
Other Deposit-Taking Institutions. 
 
File Structure 
 
Field Name Field Type Field Size Field Description  
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 

Type of Payment Association6FIN_TYPE Character 70 
 
Fire Stations (fre) 
 
The Fire Stations layer includes fire stations in the provinces of Ontario, Quebec, British Columbia, 
Alberta and Saskatchewan. 
 
File Structure 
 
Field Name Field Type Field Size Field Description  
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
STATION Character 68 Name of Fire Station 
STN_TYPE Character 3 Type of Fire Station 
 
Gasoline Service Stations (gas) 
 
The Gasoline Service Stations layer is comprised of six different gas companies: Husky, Irving, 
PetroCanada, Pioneer, Shell, and Sunoco.  Pioneer and Sunoco gas stations are provided for Ontario 
only. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
CHAIN Character 100 Gas Station Chain 
PROPANE Character 3 Propane Available 
DIESEL Character 3 Diesel Available 
 
 

                                                 
6 A complete listing of financial institutions, and their corresponding FIN_TYPE classification is found in Appendix F: Canadian 
Payments Association Classification.
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Golf Courses (glf) 
 
The Golf Courses layer contains Private and Public golf courses.  
 
File Structure 
 
Field Name Field Size Field Type Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
NUM_HOLE Character 5 Number of Holes at Golf Course 
GLF_TYPE Character 15 Golf Course Point of Interest Classification 
 
 
Health Care (hcr) 
 
The Health Care layer includes Hospitals, Long-Term Care Centers, Nursing Stations, Outpatient Clinics 
and Community Health Centers.  
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
TOTAL_BEDS Character 5 Total number of beds 
HCR_TYPE Character 1 Health Care Point of Interest Classification 
 
Contents 
 
HCR_TYPE Description 
H Acute Care Hospital 
L Long-Term Care Center 
N Nursing Station 
O Outpatient Clinic 
C Community Health Center 
 
 
Police Services (pol)7

 
The Police Services layer includes the Ontario Provincial Police (OPP), Royal Canadian Mounted Police 
(RCMP), Sûreté du Québec (SQ), the Royal Newfoundland Constabulary (RNC), and other municipal 
police services.8

 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 

                                                 
7 Source: CPIC National Directory, Canadian Police Information Centre, 2002.    
8 A complete listing of abbreviations and definitions (English/ Frençh) used in the Police Services layer is found in Appendix G : 
CPIC National Directory. 
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STN_ADMIN Character 70 Police Station or Administrator 
POL_TYPE Character 10 Police Service Point of Interest Classification 
 
Contents 
 
POL_TYPE Description 
MUN Municipal Police Service 
OPP Ontario Provincial Police 
RNC Royal Newfoundland Constabulary 
RCMP Royal Canadian Mounted Police 
SQ Sûreté du Québec  
 
 
Retail Postal Outlets (rpo) 
 
The Retail Postal Outlets layer includes over 8500 postal outlets across Canada. 
 
Note: There is no look up table for the RPO layer.  All relevant information is found in the main table. 
 
 
Shopping Centers (shp) 
 
The Shopping Centers layer includes over 2000 shopping centers across Canada. 
 
Note: There is no look up table for the SHP layer.  All relevant information is found in the main table. 
 
 
Ski Centers (ski) 
 
The Ski Centers layer is comprised of over 200 skiing facilities across Canada. 
 
Note: There is no look up table for the SKI layer.  All relevant information is found in the main table. 
 
 
Toll Booths (tol) 
 
The Toll Booths layer indicates the name and location of Toll Booths. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
DIRECTION Character 2 Direction of road that toll booth is located on 
 
Contents 
 
DIRECTION Description 
E East  
W West 
N North 
S South 
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Tourist (tou) 
 
The Tourist layer includes categories such as National, Provincial and Municipal parks, Art Galleries, 
Attractions, Fishing Resorts, Historic Sites, Museums, Science Centres, Tourist Information Booths, and 
Zoos. 
 
File Structure 
 
Field Name Field Type Field Size Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Point of Interest Classification 
TOU_TYPE Character 5 Tourist Point of Interest Classification 
SEASON Character 50 Season that Tourist POI is open  
 
Content 
 
TOU_TYPE 
 
TOU_TYPE Description 
ACH Archive 
ADV Outdoor Adventure 

Company/Tour 
AQU Aquarium 
ATT Attraction 
BCH Beach 
CAS Casino 
CEC Cultural or Environmental 

Education Center 
CUL Cultural Center 
DFS Duty-Free Shop 
FSH Fishing Lodge/Camp 
GAL Art Gallery 
GDN Garden 
GSV Government Services 

TOU_TYPE Description 
HIS Historic Site/Park/Location 
LIB Library 
MUS Museum 
NAT Nature Preserve/Conservatory 
OBS Observatory 
ORG Organization related to Arts 

and Culture 
PNT Planetarium 
PRK Park 
RLG Religious Institution 
SCI Science Centre 
SCN Scenic Site/Trail/Area 
TIB Tourist Information Board 
WTS Water Tour/Cruise 
ZOO Zoo 
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Transit Stops (trs) 
 
The Transit Stops layer contains the Type, Owner, Route and Number (if applicable). 
 
File Structure 
 
Field Name Field Size Field Type Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Classification of the EPOI 
TRS_TYPE Character 25 Transit Stop points of interest classification 
OWNER Character 68 Transit Stop points of interest ownership 
ROUTE Character 68 Transit Stop points of interest transit route 
TRS_NUM Character 8 Transit Stop points of interest number 
CODE Number  Transit Stop points of interest NTDB code 
FEATURE Character 76 Transit Stop points of interest NTDB feature 
 
 
Weigh Stations (wgh) 
 
The weigh stations layer (at a minimum) contains the Name and Address (if applicable) of each weigh 
station as well as the site type (permanent or portable scale). 
 
File Structure 
 
Field Name Field Size Field Type Field Description 
POI_ID Character 15 Unique ID (link to main EPOI database) 
EPOI_TYPE Character 3 Classification of the EPOI 
DIRECTION Character 2 Indicates the direction of road scale is on 
HOURS Character 20 Hours of operation 
YEAR_ROUND Logical  Year Round Operation 
RESTROOM Logical  Restrooms available 
WGH_TYPE Character 10 Weigh Station Point of Interest Classification 
AVION401 Logical  Avion 401 automated clearance system 
 
Contents 
 
DIRECTION Description 
N North 
S South 
E East 
W West 
O Ouest 
NS North & South (can be accessed from either direction)
EW East & West (can be accessed from either direction) 
 
WGH_Type 
 
Value Description 
Perm Permanent Scale 
Port Portable Scale 

 DMTI Spatial Inc. 625 Cochrane Dr., 3rd Floor, Markham, Ontario, Canada, L3R 9R9      
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Appendix A: Importing EPOI Data in GIS Software 
 
When importing the database please be sure to check that the X and Y fields are of the right type. 
 
MapInfo 
 
Creating a MapInfo (.tab) table 

1. Open MapInfo. 
2. File > Open Table > Select EPOI.txt file and double-click. 
3. In dialog box, for “Delimited ASCII Information” choose 

‘Other’ (comma), the ‘File Character Set’ should be 
“Windows US & W. Europe (“ANSI”)”, and check off the 
Use First Line for Column Titles.  See Figure 1. 

4. Click OK. 
5. File > Save Copy As…choose folder to save file.    
6. Open the new .tab file. 

 
Creating MapInfo Graphics from Coordinate Fields Figure 1: Delimited ASCII Information 7. Table > Create Points > Select EPOI.tab file 

8. Adjust the symbol size, colour, and shape by selecting 
“Symbol Style”.   

9. Choose the “x” field in the ‘Get X Coordinates from Column’ in the drop down box.   
10. Choose the “y” field in the ‘Get Y Coordinates from Column’ in the drop down box.   
11. Click on Projection, select the Category (Longitude/Latitude) and the Category Member 

(Longitude/Latitude (NAD83)) 
12. Click OK. 

 
Main EPOICreating MapInfo Lookup tables  EPOI look up table

13. Repeat steps 1 to 6 
 
Linking the EPOI table to the EPOI Lookup tables  

14. Open the EPOI table and the EPOI look up 
tables in MapInfo 

15. Select Query > SQL select. 
16. Click on “from Tables” box and click “Tables”, 

select the EPOI table and the look up table 
17. Click on “where Condition” box, enter the 

condition so that the POI_ID from each table is 
equal. 

18. Click on “into Table Named” box and name the 
new file. See Figure 2. 

 

Figure 2: Linking the EPOI table to the EPOI Lookup 
tables  
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ArcView 3.x 
 
Opening txt file(s) and making ArcView files (*.shp) 

1. Open ArcView > New Project as a blank project. 
2. From the Project Window, click on ‘Tables’.  Click “Add”.  Change the ‘List Files of Type’ to 

“Delimited Text (*.txt), then navigate to the EPOI.txt file(s).  Click OK. 
 

Figure 3: Creating ArcView files 

Creating Graphics from Coordinate Fields 
3. In Project Window, click ‘Views’.  Press “New” to add a view. 
4. Select View > Add Event Theme.  Select the correct table, and X/Y coordinate fields from the 

EPOI.txt file.  Click OK.  
5. In the View select the EPOI.txt layer to make the layer active.   
6. Select Theme > Convert to Shapefile > Navigate to the location where the files will be saved.  

Name the file and Click OK.  When ArcView asks to add the shapefile as a theme to the view, 
Press YES.  The new theme with the .shp extension will appear in the view. 

 
Creating Projection Datum Metadata (*.prj files): 

7. In the same project, from the Menu > File > Extensions.  Scroll down to Projection Utility Wizard, 
click on the checkbox and Click OK. 

8. File > ArcView Projection Utility.  In Step 1, select the shape file and press Next.  In Step 2, the 
‘Coordinate System Type’ should be “Geographic”.  From the ‘Name’ dropdown box, select 
“GCS_North_American_1983 [4269]”, and the units in “Degree [9102]”, then press Next.  ArcView 
will ask to save the coordinate system information, press Yes and a Project file (*.prj) will be 
created with the shape files.  Cancel out of the Utility.  To continue would actually re-project the 
files. 

 
Opening Lookup tables in ArcView: 

9. In the same project, click from the Project Window – Tables.  Press Add to bring in the lookup 
table.  Click Open to see the database.   

10. File – Export – this will convert the text file to a dBASE format for ArcView.  Select the location to 
save and press OK.   

11. The text version of the lookup table can be deleted from the project.  Open the new dBASE file. 
12. Repeat for each lookup table as required. 
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Linking Lookup tables to the main EPOI table 
 
To view the main EPOI table linked to the Look up tables, the files should be manually joined.  To join the 
files use the following directions: 

13. View both the main EPOI table and the Look up table (attribute tables) 
14. Click on the POI_ID fields from both the main EPOI table and the Look up table 
15. Click on the Join button (or choose Join from the Table menu).   
16. Additional Look up tables can be joined, so that many tables’ attributes can be shown at one time.  

To undo the joins between the tables, click on the attribute table, making it active, and from the 
‘Table’ menu select ‘Remove All Joins’.  

 
ArcGIS 8.3 
 
Opening txt file(s) and Creating ArcMap files: 

1. Start with a new empty map.  Click OK. 
2. File > Add Data > navigate to the EPOI.txt 

files and Click Add. 
 
Note:  “ON” is an SQL statement in ArcGIS and 
therefore ON.txt cannot be opened and must be 
renamed as ONT.txt.  The renaming of this file 
will not affect the link to the Ontario lookup table.  

 
Creating Graphics from Coordinate Fields: 

3. Tools > Add X, Y Data > choose the table 
and the X, Y fields. 

4. Choose the coordinate system by clicking 
Edit.  Then from ‘Select Coordinate System’, 
select Geographical Coordinate System, then 
North America, then North American Datum 
1983.  Click Add, then Apply, then OK.  A 
project file (*.prj) is created containing the 
coordinate information. 

5. Make the event theme active (ie. EPOI.txt 
Events). 

6. Right click on the ‘Events’ theme, choose 
‘Data’, then ‘Export Data’.  Export all 
features.  Click on the ‘Use the same 
Coordinate System as the data frame’ button.  
Browse to specify where the theme will be 
stored.  Click OK.  

7. ArcMap will ask to add the layer to the view.  
Click Yes.  Remove the ‘Events’ theme. 

Figure 4: Creating graphics from coordinate fields  
Opening Lookup Tables in ArcMap 

8. Repeat the first two steps under “Opening txt files and creating ArcMap files” to open the Lookup 
tables. Right click on the Lookup table and select ‘Open’ to view. 

 
Linking Lookup tables to the main EPOI table 
 
To view the main EPOI table linked to the Look up tables, the files must be manually joined together.   

9. Add both the main EPOI table and Lookup table to the Layers.  Right click the Lookup table and 
select ‘Joins and Relates’ > ‘Join’. 

10. Choose the field the join will be based on (i.e. POI_ID), then select the table to join too, and Click 
OK. 
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Appendix B:  Provincial and Territorial Abbreviations and Codes9

 
The provincial/territorial names, abbreviations and numeric codes reflect those in effect on January 1, 
2001 with the exception of the name change of the province of Newfoundland and Labrador (previously 
Newfoundland), which came into effect on December 6, 2001.  Newfoundland and Labrador was 
recognized by the alpha code NL (formerly NF). There were no changes to the numeric code (10) and 
abbreviations for Newfoundland and Labrador.  
 
On April 1, 1999 the Northwest Territories was divided into two territories to create Nunavut Territory.  
The province/territory numeric code for Nunavut is 62 whereas the code for the Northwest Territories 
remained at 61. On December 18, 2000, Canada Post has introduced a new alpha code (NU) for 
Nunavut.   
 

Province/Territory (English) Province/Territory (French) Abbreviation10 Numeric Code 
Alberta Alberta AB 48 
British Columbia Colombie-Britannique BC 59 
Manitoba Manitoba MB 46 
New Brunswick Nouveau-Brunswick NB 13 
Newfoundland and Labrador Terre-Neuve-et-Labrador NL 10 
Nova Scotia Nouvelle-Écosse NS 12 
Northwest Territories Territoires du Nord-Ouest NT 61 
Nunavut Nunavut NU 62 
Ontario Ontario ON 35 
Prince Edward Island Île-du-Prince-Édouard PE 11 
Québec Québec QC 24 
Saskatchewan Saskatchewan SK 47 
Yukon  Yukon YT 60 
 

                                                 
9 Source: Statistics Canada, Standard Geographical Classification (SGC) 2001 
10 Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002 
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Appendix C:  Canadian Urban Areas and Abbreviations 

Canadian urban areas are based upon DMTI’s topographic coverage areas.   The following table is a 
partial list of urban areas and their abbreviations.  For a complete listing of Canadian urban areas refer to 
the CANtop file located in the Canada Directory or for information regarding other areas contact DMTI 
Spatial.  
 
Province Topographic Coverage Area Abbreviation 
AB Calgary CLGRY 
AB Edmonton EDMNT 
BC Vancouver VNCVR 
BC Victoria VCTRA 
MB Winnipeg WINPG 
NB Fredericton FRDTN 
NB Saint John STJON 
NL Labrador City LBDRC 
NL St. John's STJHN 
NS Halifax HALFX 
NT Yellowknife YLKNF 
NU Iqaluit IQALT 
ON Greater Toronto Area GTA 
ON Hamilton Niagara HAMNG 
ON Ottawa OTAWA 
PE Charlottetown CHLTN 
QC Hull HULL 
QC Montreal MNTRL 
QC Quebec City QBCTY 
SK Regina RGNA 
YT Whitehorse WTHRS 
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Appendix D: Standard Industrial Classification Codes  
 
What is an SIC Code? 
 
Standard Industrial Classification (SIC) codes are four digit* numerical codes that were established in 
1987 by the U.S. Government.  The codes were assigned to businesses to group and identify their 
primary area of business activity and to facilitate the collection of economic data for statistical analysis by 
federal, state, and private organizations.  The SIC code classifications cover all economic related 
activities including agriculture, forestry & fishing; mining; construction; manufacturing; transportation, 
communications, electric, gas, and sanitary services; wholesale trade; retail trade; finance, insurance, 
real estate; health, education, recreation and other services; and public administration. 
 
* To accommodate for future changes to the SIC code DMTI has adopted a policy of representing the 
code with eight (8) characters. The four zeroes at the end of the code are a temporary space holder. 
 
SIC Division 
 
SIC Division is represented by a single letter, for example Division G refers to Retail Trade. Each Division 
represents a broad area of economic activity: 
 
Division Description SIC Range 
A Agriculture, Forestry, And Fishing  01 to 09 
B Mining  10 to 14 
C Construction 15 to 17 
D Manufacturing  20 to 39 
E Transportation, Communications, Electric, Gas, And Sanitary Services 40 to 49 
F Wholesale Trade  50 to 51 
G Retail Trade  52 to 59 
H Finance, Insurance, And Real Estate  60 to 67 
I Services  70 to 88 
J Public Administration  90 to 99 
K Unclassified 00 
 
SIC Major Group  
 
SIC Major Group represents the first two digits of the code for example, Major Group 80 refers to Health 
Services.  Each Major Group represents a sector or industry group: 
 
Major Group Description SIC Range 
01 Agricultural Production Crops  0111 to 0191 
02 Agricultural Production Livestock And Animal Specialties  0211 to 0291 
07 Agricultural Services 0711 to 0783 
08 Forestry 0811 to 0851 
09 Fishing, Hunting, And Trapping 0911 to 0971 
10 Metal Mining 1011 to 1099 
12 Coal Mining 1221 to 1241 
13 Oil And Gas Extraction 1311 to 1389 
14 Mining And Quarrying Of Nonmetallic Minerals, Except Fuels  1411 to 1499 
15 Building Construction General Contractors And Operative Builders  1521 to 1542 
16 Heavy Construction Other Than Building Construction Contractors 1611 to 1629 
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Major Group Description SIC Range 
17 Construction Special Trade Contractors  1711 to 1799 
20 Food And Kindred Products 2011 to 2099 
21 Tobacco Products  2111 to 2141 
22 Textile Mill Products  2211 to 2299 

23 
Apparel And Other Finished Products Made From Fabrics And Similar 
Materials 2311 to 2399 

24 Lumber And Wood Products, Except Furniture  2411 to 2499 
25 Furniture And Fixtures  2511 to 2599 
26 Paper And Allied Products  2611 to 2679 
27 Printing, Publishing, And Allied Industries  2711 to 2796 
28 Chemicals And Allied Products  2812 to 2899 
29 Petroleum Refining And Related Industries 2911 to 2999 
30 Rubber And Miscellaneous Plastics Products  3011 to 3089 
31 Leather And Leather Products  3111 to 3199 
32 Stone, Clay, Glass, And Concrete Products 3211 to 3299 
33 Primary Metal Industries  3312 to 3399 

34 
Fabricated Metal Products, Except Machinery And Transportation 
Equipment  3411 to 3499 

35 Industrial And Commercial Machinery And Computer Equipment  3511 to 3599 

36 
Electronic And Other Electrical Equipment And Components, Except 
Computer Equipment  3612 to 3699 

37 Transportation Equipment  3711 to 3799 

38 
Measuring, Analyzing, And Controlling Instruments; Photographic, 
Medical And Optical Goods; Watches And Clocks 3812 to 3873 

39 Miscellaneous Manufacturing Industries  3911 to 3999 
40 Major Group 40: Railroad Transportation  4011 to 4013 

41 
Local And Suburban Transit And Interurban Highway Passenger 
Transportation  4111 to 4173 

42 Motor Freight Transportation And Warehousing  4212 to 4231 
43 United States Postal Service  4311 to 4311 
44 Water Transportation  4412 to 4499 
45 Transportation By Air  4512 to 4581 
46 Pipelines, Except Natural Gas  4612 to 4619 
47 Transportation Services  4724 to 4789 
48 Communications 4812 to 4899 
49 Electric, Gas, And Sanitary Services 4911 to 4971 
50 Wholesale Trade-durable Goods 5012 to 5099 
51 Wholesale Trade-non-durable Goods 5111 to 5199 

52 
Building Materials, Hardware, Garden Supply, And Mobile Home 
Dealers  5211 to 5271 

53 General Merchandise Stores 5311 to 5399 
54 Food Stores  5411 to 5499 
55 Automotive Dealers And Gasoline Service Stations  5511 to 5599 
56 Apparel And Accessory Stores  5611 to 5699 
57 Home Furniture, Furnishings, And Equipment Stores  5712 to 5736 
58 Eating And Drinking Places  5812 to 5813 
59 Miscellaneous Retail  5912 to 5999 
60 Depository Institutions  6011 to 6099 
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Description SIC Range Major Group 
61 Non-depository Credit Institutions  6111 to 6163 
62 Security And Commodity Brokers, Dealers, Exchanges, And Services  6211 to 6289 
63 Insurance Carriers  6311 to 6399 
64 Insurance Agents, Brokers, And Service  6411 to 6411 
65 Real Estate  6512 to 6553 
67 Holding And Other Investment Offices 6712 to 6799 
70 Hotels, Rooming Houses, Camps, And Other Lodging Places  7011 to 7041 
72 Personal Services  7211 to 7299 
73 Business Services 7311 to 7389 
75 Automotive Repair, Services, And Parking  7513 to 7549 
76 Miscellaneous Repair Services  7622 to 7699 
78 Motion Pictures 7812 to 7841 
79 Amusement And Recreation Services  7911 to 7999 
80 Health Services 8011 to 8099 
81 Legal Services  8111 to 8111 
82 Educational Services  8211 to 8299 
83 Social Services  8322 to 8399 
84 Museums, Art Galleries, And Botanical And Zoological Gardens  8412 to 8422 
86 Membership Organizations  8611 to 8699 

87 
Engineering, Accounting, Research, Management, And Related 
Services  8711 to 8748 

88 Private Households 8811 to 8811 
91 Executive, Legislative, And General Government, Except Finance  9111 to 9199 
92 Justice, Public Order, And Safety  9111 to 9229 
93 Public Finance, Taxation, And Monetary Policy  9311 to 9311 
94 Administration Of Human Resource Programs  9411 to 9451 
95 Administration Of Environmental Quality And Housing Programs 9511 to 9532 
96 Administration Of Economic Programs  9611 to 9661 
97 National Security And International Affairs  9711 to 9721 
99 No classifiable Establishments  9999 to 9999 
00 Unclassified  0000 to 0000 
 
SIC Code  
 
SIC Code represents the four digits of the code, for example SIC Code 5431 refers to Fruit and Vegetable 
Markets. Each SIC Code represents specific products or services for a business: 
SIC Code Description of SIC Code 
0134 Irish Potatoes 
0161 Vegetables And Melons 
0171 Berry Crops 
0175 Deciduous Tree Fruits 
0181 Ornamental Floriculture And Nursery Products 
0182 Food Crops Grown Under Cover 
0191 General Farms Primarily Crop 
0211 Beef Cattle Feedlots 
0212 Beef Cattle Except Feedlots 
0219 General Livestock Nec 
0254 Poultry Hatcheries 
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SIC Code Description of SIC Code 
0259 Poultry And Eggs Nec 
0271 Fur-bearing Animals And Rabbits 
0272 Horses And Other Equines 
0273 Animal Aquaculture 
0279 Animal Specialties Nec 
0721 Crop Planting And Protection 
0723 Crop Preparation Services For Market 
0742 Veterinary Services For Animal Specialties 
0751 Livestock Services Exc. Veterinary 
0752 Animal Specialty Services 
0761 Farm Labor Contractors 
0762 Farm Management Services 
0781 Landscape Counseling And Planning 
0782 Lawn And Garden Services 
0783 Ornamental Shrub And Tree Services 
0811 Timber Tracts 
0831 Forest Nurseries And Gathering Of Forest Products 
0851 Forestry Services 
0912 Finfish 
0913 Shellfish 
0919 Miscellaneous Marine Products 
0921 Fish Hatcheries And Preserves 
0971 Hunting Trapping Game Propagation 
1000 Mining 
1011 Iron Ores 
1041 Gold Ores 
1081 Metal Mining Services 
1099 Metal Ores Nec 
1221 Bituminous Coal And Lignite Surface Mining 
1311 Crude Petroleum And Natural Gas 
1381 Drilling Oil And Gas Wells 
1382 Oil And Gas Exploration Services 
1389 Oil And Gas Field Services Nec 
1411 Dimension Stone 
1422 Crushed And Broken Limestone 
1423 Crushed And Broken Granite 
1429 Crushed And Broken Stone Nec 
1442 Construction Sand And Gravel 
1499 Nonmetallic Minerals Nec 
1521 Single-family Housing Construction 
1541 Industrial Buildings And Warehouses 
1542 Nonresidential Construction Nec 
1611 Highway And Street Construction 
1622 Bridge Tunnel And Elevated Highway 
1623 Water Sewer And Utility Lines 
1629 Heavy Construction Nec 
1711 Plumbing Heating Air Conditioning 
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SIC Code Description of SIC Code 
1721 Painting And Paper Hanging 
1731 Electrical Work 
1741 Masonry And Other Stonework 
1742 Plastering Dry Wall And Insulation 
1743 Terrazzo Tile Marble Mosaic Work 
1751 Carpentry Work 
1752 Floor Laying And Floor Work Nec 
1761 Roofing Siding And Sheet Metal Work 
1771 Concrete Work 
1781 Water Well Drilling 
1791 Structural Steel Erection 
1793 Glass And Glazing Work 
1794 Excavation Work 
1795 Wrecking And Demolition Work 
1796 Installing Building Equipment Nec 
1799 Special Trade Contractors Nec 
2011 Meat Packing Plants 
2013 Sausages And Other Prepared Meats 
2021 Creamery Butter 
2022 Cheese Natural And Processed 
2023 Dry Condensed And Evaporated Milk 
2024 Ice Cream And Frozen Desserts 
2026 Fluid Milk 
2032 Canned Specialties 
2033 Canned Fruits Vegetables Preserves Jams And Jellies 
2034 Dehydrated Fruits Vegetables Soups 
2035 Pickles Sauces And Salad Dressings 
2037 Frozen Fruits Juices And Vegetables 
2041 Flour And Other Grain Mill Products 
2043 Cereal Breakfast Foods 
2044 Rice Milling 
2045 Blended And Prepared Flour 
2046 Wet Corn Milling 
2047 Dog And Cat Food 
2048 Prepared Feeds Nec 
2051 Bread Cake And Related Products 
2052 Cookies And Crackers 
2062 Cane Sugar Refining 
2064 Candy And Other Confectionery Products 
2066 Chocolate And Cocoa Products 
2067 Chewing Gum 
2075 Soybean Oil Mills 
2077 Animal And Marine Fats And Oils 
2079 Shortening And Cooking Oils 
2082 Malt Beverages 
2083 Malt 
2084 Wines Brandy And Brandy Spirits 
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SIC Code Description of SIC Code 
2085 Distilled And Blended Liquors 
2086 Bottled And Canned Soft Drinks 
2087 Flavoring Extracts And Syrups Nec 
2091 Canned And Cured Fish And Seafoods 
2092 Fresh Or Frozen Packaged Fish 
2096 Potato Chips Corn Chips And Similar Snacks 
2097 Manufactured Ice 
2099 Food Preparations Nec 
2111 Cigarettes 
2211 Weaving Mills Cotton 
2221 Weaving Mills Synthetic Fibres 
2231 Weaving And Finishing Mills Wool 
2241 Narrow Fabric Mills 
2251 Women's Hosiery Except Socks 
2253 Knit Outerwear Mills 
2257 Circular Knit Fabric Mills 
2258 Warp Knit Fabric Mills 
2269 Finishing Plants Nec 
2273 Carpets And Rugs 
2281 Yarn Spinning Mills 
2295 Coated Fabrics Not Rubberized 
2297 Nonwoven Fabrics 
2298 Cordage And Twine 
2299 Textile Goods Nec 
2311 Men's And Boys' Suits And Coats 
2321 Men's And Boys' Shirts 
2322 Men's And Boys' Underwear And Nightwear 
2323 Men's And Boys' Neckwear 
2325 Men's And Boys' Separate Trousers 
2326 Men's And Boys' Work Clothing 
2329 Men's And Boys' Clothing Nec 
2331 Women's And Misses' Blouses And Waists 
2335 Women's And Misses' Dresses 
2337 Women's And Misses' Suits And Coats 
2339 Women's And Misses' Outerwear Nec 
2341 Women's And Children's Underwear And Nightwear 
2342 Brassieres And Allied Garments 
2353 Hats Caps And Millinery 
2361 Girls' And Children's Dresses And Blouses 
2371 Fur Goods 
2381 Fabric Dress And Work Gloves 
2385 Waterproof Outerwear 
2386 Leather And Sheep Lined Clothing 
2387 Apparel Belts 
2389 Apparel And Accessories Nec 
2391 Curtains And Draperies 
2392 House Furnishings Nec 
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2393 Textile Bags 
2394 Canvas And Related Products 
2395 Pleating And Stitching 
2396 Automotive And Apparel Trimmings 
2399 Fabricated Textile Products Nec 
2411 Logging 
2421 Sawmills And Planing Mills General 
2426 Hardwood Dimension And Flooring 
2429 Special Product Sawmills Nec 
2431 Millwork 
2435 Hardwood Veneer And Plywood 
2439 Structural Wood Members Nec 
2441 Nailed Wood Boxes And Shook 
2448 Wood Pallets And Skids 
2451 Mobile Homes 
2452 Prefabricated Wood Buildings 
2491 Wood Preserving 
2493 Reconstituted Wood Products 
2499 Wood Products Nec 
2511 Wood Household Furniture 
2515 Mattresses Foundations And Convertible Beds 
2522 Metal Office Furniture 
2531 Public Building And Related Furniture 
2541 Wood Partitions And Fixtures 
2542 Metal Partitions And Fixtures 
2591 Drapery Hardware And Blinds And Shades 
2599 Furniture And Fixtures Nec 
2611 Pulp Mills 
2621 Paper Mills 
2631 Paperboard Mills 
2652 Set-up Paperboard Boxes 
2653 Corrugated And Solid Fiber Boxes 
2655 Fiber Cans Drums And Similar Products 
2657 Folding Paperboard Boxes 
2672 Coated And Laminated Paper Nec 
2673 Plastics Foil And Coated Paper Bags 
2674 Uncoated Paper And Multiwall Bags 
2676 Sanitary Paper Products 
2677 Envelopes 
2678 Stationery Tablets And Related Products 
2679 Converted Paper And Paperboard Products Nec 
2711 Newspapers 
2721 Periodicals 
2731 Book Publishing 
2741 Miscellaneous Publishing 
2752 Commercial Printing Lithographic 
2754 Commercial Printing Gravure 
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2759 Commercial Printing Nec 
2761 Manifold Business Forms 
2771 Greeting Cards 
2782 Blankbooks And Looseleaf Binders 
2789 Bookbinding And Related Work 
2791 Typesetting 
2796 Platemaking And Related Services 
2812 Alkalies And Chlorine 
2813 Industrial Gases 
2816 Inorganic Pigments 
2819 Industrial Inorganic Chemicals Nec 
2821 Plastics Materials And Resins 
2822 Synthetic Rubber 
2833 Medicinal Chemicals And Botanical Products 
2834 Pharmaceutical Preparations 
2842 Polishes And Sanitation Goods 
2844 Toilet Preparations 
2851 Paints And Allied Products 
2861 Gum And Wood Chemicals 
2865 Cyclic Crudes And Intermediates 
2869 Industrial Organic Chemicals Nec 
2873 Nitrogenous Fertilizers 
2879 Pesticides And Agricultural Chemicals Nec 
2891 Adhesives And Sealants 
2892 Explosives 
2893 Printing Ink 
2895 Carbon Black 
2899 Chemical Preparations Nec 
2911 Petroleum Refining 
2951 Asphalt Paving Mixtures And Blocks 
2992 Lubricating Oils And Greases 
2999 Petroleum And Coal Products Nec 
3011 Tires And Inner Tubes 
3021 Rubber And Plastics Footwear 
3052 Rubber And Plastic Hose And Belting 
3053 Gaskets Packing And Sealing Devices 
3061 Molded Extruded And Lathe-Cut Mechanical Rubber Products 
3069 Fabricated Rubber Products Nec 
3081 Unsupported Plastics Film And Sheet 
3083 Laminated Plastics Plate Sheet And Profile Shapes 
3084 Plastics Pipe 
3086 Plastics Foam Products 
3088 Plastics Plumbing Fixtures 
3089 Plastics Products Nec 
3111 Leather Tanning And Finishing 
3131 Footwear Cut Stock 
3161 Luggage 
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3171 Women's Handbags And Purses 
3172 Personal Leather Goods Nec 
3199 Leather Goods Nec 
3221 Glass Containers 
3229 Pressed And Blown Glass Nec 
3231 Products Of Purchased Glass 
3241 Cement Hydraulic 
3253 Ceramic Wall And Floor Tile 
3255 Clay Refractories 
3262 Vitreous China Table And Kitchen Articles 
3264 Porcelain Electrical Supplies 
3269 Pottery Products Nec 
3271 Concrete Block And Brick 
3272 Concrete Products Nec 
3273 Ready-mixed Concrete 
3274 Lime 
3275 Gypsum Products 
3281 Cut Stone And Stone Products 
3291 Abrasive Products 
3292 Asbestos Products 
3295 Minerals and Earths, Ground or Otherwise Treated 
3296 Mineral Wool 
3299 Nonmetallic Mineral Products Nec 
3312 Blast Furnaces And Steel Mills 
3315 Steel Wire And Related Products 
3316 Cold Finishing Of Steel Shapes 
3317 Steel Pipe And Tubes 
3321 Gray Iron Foundries 
3324 Steel Investment Foundries 
3325 Steel Foundries Nec 
3331 Primary Copper 
3334 Primary Aluminum 
3339 Primary Nonferrous Metals Nec 
3341 Secondary Smelting And Refining Of Nonferrous Metals 
3351 Copper Rolling And Drawing 
3353 Aluminum Sheet Plate And Foil 
3355 Aluminum Rolling And Drawing Nec 
3356 Nonferrous Rolling And Drawing Nec 
3364 Nonferrous Die-Castings Except Aluminum 
3398 Metal Heat Treating 
3399 Primary Metal Products Nec 
3411 Metal Cans 
3412 Metal Barrels Drums And Pails 
3421 Cutlery 
3423 Hand And Edge Tools Nec 
3429 Hardware Nec 
3431 Metal Sanitary Ware 
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3432 Plumbing Fittings And Brass Goods 
3433 Heating Equipment Except Electric 
3441 Fabricated Structural Metal 
3442 Metal Doors Sash And Trim 
3443 Fabricated Plate Work (Boiler Shops) 
3444 Sheet Metal Work 
3446 Architectural Metal Work 
3448 Prefabricated Metal Buildings 
3449 Miscellaneous Metal Work 
3451 Screw Machine Products 
3452 Bolts Nuts Rivets And Washers 
3462 Iron And Steel Forgings 
3463 Nonferrous Forgings 
3466 Crowns And Closures 
3469 Metal Stampings Nec 
3471 Plating And Polishing 
3479 Coating Engraving And Allied Services 
3484 Small Arms 
3491 Industrial Valves 
3492 Fluid Power Valves And Hose Fittings 
3494 Valves And Pipe Fittings Nec 
3495 Wire Springs 
3496 Misc. Fabricated Wire Products 
3498 Fabricated Pipe And Fittings 
3499 Fabricated Metal Products Nec 
3511 Turbines And Turbine Generator Sets 
3519 Internal Combustion Engines Nec 
3523 Farm Machinery And Equipment 
3531 Construction Machinery 
3533 Oil And Gas Field Machinery 
3535 Conveyors And Conveying Equipment 
3536 Hoists Cranes And Monorails 
3537 Industrial Trucks And Tractors 
3541 Machine Tools Metal Cutting Types 
3542 Machine Tools Metal Forming Types 
3543 Industrial Patterns 
3544 Special Dies Tools Jigs And Fixtures 
3545 Machine Tool Accessories 
3546 Power Driven Hand Tools 
3548 Welding Equipment 
3549 Metalworking Machinery Nec 
3552 Textile Machinery 
3553 Woodworking Machinery 
3554 Paper Industries Machinery 
3555 Printing Trades Machinery 
3556 Food Products Machinery 
3559 Special Industry Machinery Nec 
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3564 Blowers And Fans 
3565 Packaging Machinery 
3566 Speed Changers Drives And Gears 
3567 Industrial Furnaces And Ovens 
3568 Power Transmission Equipment Nec 
3569 General Industrial Machinery Nec 
3571 Electronic Computers 
3577 Computer Peripheral Equipment Nec 
3579 Office Machines Nec 
3581 Automatic Vending Machines 
3582 Commercial Laundry Equipment 
3585 Refrigeration And Heating Equipment 
3589 Service Industry Machinery Nec 
3599 Machinery Except Electrical Nec 
3612 Transformers 
3613 Switchgear And Switchboard Apparatus 
3621 Motors And Generators 
3624 Carbon And Graphite Products 
3625 Relays And Industrial Controls 
3629 Electrical Industrial Apparatus Nec 
3631 Household Cooking Equipment 
3632 Household Refrigerators And Freezers 
3633 Household Laundry Equipment 
3634 Electric Housewares And Fans 
3635 Household Vacuum Cleaners 
3639 Household Appliances Nec 
3641 Electric Lamps Bulbs And Tubes 
3643 Current-carrying Wiring Devices 
3644 Noncurrent-carrying Wiring Devices 
3645 Residential Lighting Fixtures 
3646 Commercial Lighting Fixtures 
3648 Lighting Equipment Nec 
3652 Phonograph Records And Prerecorded Audio Tapes And Disks 
3661 Telephone And Telegraph Apparatus 
3663 Radio And TV Broadcasting Equipment 
3669 Communications Equipment Nec 
3672 Printed Circuit Boards 
3674 Semiconductors And Related Devices 
3675 Electronic Capacitors 
3676 Electronic Resistors 
3679 Electronic Components Nec 
3694 Engine Electrical Equipment 
3695 Magnetic And Optical Recording Media 
3699 Electrical Equipment And Supplies Nec 
3711 Motor Vehicles And Car Bodies 
3713 Truck And Bus Bodies 
3714 Motor Vehicle Parts And Accessories 
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3715 Truck Trailers 
3721 Aircraft 
3724 Aircraft Engines And Engine Parts 
3728 Aircraft Equipment Nec 
3731 Ship Building And Repairing 
3732 Boat Building And Repairing 
3743 Railroad Equipment 
3751 Motorcycles Bicycles And Parts 
3769 Space Vehicle Equipment Nec 
3792 Travel Trailers And Campers 
3799 Transportation Equipment Nec 
3812 Search And Navigation Equipment 
3822 Environmental Controls 
3823 Process Control Instruments 
3824 Fluid Meters And Counting Devices 
3825 Instruments To Measure Electricity 
3827 Optical Instruments And Lenses 
3829 Measuring And Controlling Devices Nec 
3842 Surgical Appliances And Supplies 
3844 X-Ray Apparatus And Tubes 
3845 Electromedical Apparatus 
3851 Ophthalmic Goods 
3861 Photographic Equipment And Supplies 
3873 Watches Clocks And Watchcases 
3911 Jewelry Precious Metal 
3914 Silverware and Plated Ware 
3915 Jewelers' Materials And Lapidary Work 
3931 Musical Instruments 
3944 Games Toys And Children's Vehicles 
3949 Sporting And Athletic Goods Nec 
3951 Pens And Mechanical Pencils 
3953 Marking Devices 
3955 Carbon Paper And Inked Ribbons 
3961 Costume Jewelry 
3965 Fasteners Buttons Needles And Pins 
3991 Brooms And Brushes 
3993 Signs And Advertising Displays 
3995 Burial Caskets 
3996 Hard Surface Floor Coverings 
3999 Manufacturing Industries Nec 
4011 Railroads Line-haul Operating 
4111 Local And Suburban Transit 
4119 Local Passenger Transportation Nec 
4121 Taxicabs 
4131 Intercity Highway Transportation 
4142 Charter Service Except Local 
4212 Local Trucking Without Storage 
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4213 Trucking Except Local 
4214 Local Trucking And Storage 
4215 Courier Services Except By Air 
4221 Farm Product Warehousing And Storage 
4222 Refrigerated Warehousing 
4225 General Warehousing And Storage 
4226 Special Warehousing And Storage Nec 
4311 Canadian Postal Service 
4412 Deep Sea Foreign Transportation Of Freight 
4449 Water Transportation Of Freight Nec 
4482 Ferries 
4489 Water Transportation Of Passengers Nec 
4491 Marine Cargo Handling 
4492 Towing and Tugboat Services 
4493 Marinas 
4499 Water Transportation Services Nec 
4512 Air Transportation Scheduled 
4513 Air Courier Services 
4522 Air Transportation Nonscheduled 
4581 Airports Flying Fields And Airport Terminal Services 
4619 Pipelines Nec 
4724 Travel Agencies 
4725 Tour Operators 
4729 Arrangement Of Passenger Transportation Nec 
4731 Arrangement Of Transportation Of Freight And Cargo 
4741 Rental Of Railroad Cars 
4783 Packing And Crating 
4785 Inspection And Weighing Services For Motor Vehicles 
4789 Transportation Services Nec 
4812 Radiotelephone Communications 
4813 Telephone Communications Except Radiotelephone 
4822 Telegraph And Other Message Communications 
4832 Radio Broadcasting 
4833 Television Broadcasting 
4841 Cable And Other Pay Television Services 
4899 Communications Services Nec 
4911 Electric Services 
4925 Gas Production And/Or Distribution 
4941 Water Supply 
4953 Refuse Systems 
4959 Sanitary Services Nec 
4961 Steam Supply 
5012 Automobiles And Other Motor Vehicles 
5013 Automotive Parts And Supplies 
5014 Tires And Tubes 
5015 Motor Vehicles Parts Used 
5021 Furniture 
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5023 Home Furnishings 
5031 Lumber Plywood And Millwork 
5032 Brick Stone And Related Construction Materials 
5033 Roofing Siding And Insulation Materials 
5039 Construction Materials Nec 
5043 Photographic Equipment And Supplies 
5044 Office Equipment 
5045 Computer Equipment And Software 
5046 Commercial Equipment Nec 
5047 Medical Dental And Hospital Equipment And Supplies 
5048 Ophthalmic Goods 
5049 Professional Equipment Nec 
5051 Metals Service Centers And Offices 
5052 Coal And Other Minerals And Ores 
5063 Electrical Apparatus And Equipment 
5064 Electrical Appliances TV And Radios 
5065 Electronic Parts And Equipment 
5072 Hardware 
5074 Plumbing And Hydronic Heating Supplies 
5075 Warm Air Heating And Air Conditioning 
5078 Refrigeration Equipment And Supplies 
5082 Construction And Mining Machinery 
5083 Farm And Garden Machinery And Equipment 
5084 Industrial Machinery And Equipment 
5085 Industrial Supplies 
5087 Service Establishment Equipment And Supplies 
5088 Transportation Equipment And Supplies 
5091 Sporting And Recreational Goods And Supplies 
5092 Toys And Hobby Goods And Supplies 
5093 Scrap And Waste Materials 
5094 Jewelry Watches And Precious Stones 
5099 Durable Goods Nec 
5111 Printing And Writing Paper 
5112 Stationery And Office Supplies 
5113 Industrial And Personal Service Paper 
5122 Drugs Proprietaries And Sundries 
5131 Piece Goods Notions And Other Dry Goods 
5137 Women's And Children's Clothing 
5139 Footwear 
5141 Groceries General Line 
5142 Packaged Frozen Foods 
5143 Dairy Products 
5144 Poultry And Poultry Products 
5145 Confectionery 
5146 Fish And Seafoods 
5147 Meats And Meat Products 
5148 Fresh Fruits and Vegetables 
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5149 Groceries And Related Products Nec 
5153 Grain And Field Beans 
5154 Livestock 
5159 Farm-product Raw Materials Nec 
5162 Plastics Materials And Basic Forms And Shapes 
5169 Chemicals And Allied Products Nec 
5172 Petroleum Products Nec 
5182 Wines And Distilled Beverages 
5191 Farm Supplies 
5192 Books Periodicals And Newspapers 
5193 Flowers Nursery Stock And Florists' Supplies 
5194 Tobacco And Tobacco Products 
5199 Nondurable Goods Nec 
5211 Lumber And Other Building Materials 
5231 Paint Glass And Wallpaper Stores 
5251 Hardware Stores 
5261 Retail Nurseries And Garden Stores 
5271 Mobile Home Dealers 
5311 Department Stores 
5331 Variety Stores 
5399 Misc. General Merchandise Stores 
5411 Grocery Stores 
5421 Meat And Fish Markets 
5431 Fruit And Vegetable Markets 
5441 Candy Nut And Confectionery Stores 
5451 Dairy Products Stores 
5461 Retail Bakeries 
5499 Miscellaneous Food Stores 
5511 New Car Dealers 
5521 Used Car Dealers 
5531 Auto And Home Supply Stores 
5541 Gasoline Service Stations 
5551 Boat Dealers 
5561 Recreational Vehicles Dealers 
5571 Motorcycle Dealers 
5599 Automotive Dealers Nec 
5611 Men's And Boys' Clothing And Furnishings 
5621 Women's Clothing Stores 
5632 Women's Accessory And Specialty Stores 
5641 Children's And Infants' Wear Stores 
5651 Family Clothing Stores 
5661 Shoe Stores 
5699 Miscellaneous Apparel And Accessories 
5712 Furniture Stores 
5713 Floor Covering Stores 
5714 Drapery And Upholstery Stores 
5719 Misc. Home Furnishings Stores 
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5722 Household Appliance Stores 
5731 Radio Television And Consumer Electronics Stores 
5734 Computer And Computer Software Stores 
5735 Record And Pre Recorded Tape Stores 
5736 Musical Instrument Stores 
5812 Eating Places 
5813 Drinking Places 
5912 Drug Stores And Proprietary Stores 
5921 Liquor Stores 
5932 Used Merchandise Stores 
5941 Sporting Goods And Bicycle Shops 
5942 Book Stores 
5943 Stationery Stores 
5944 Jewelry Stores 
5945 Hobby Toy And Game Shops 
5946 Camera And Photographic Supply Stores 
5947 Gift Novelty And Souvenir Shops 
5948 Luggage And Leather Goods Stores 
5949 Sewing Needlework And Piece Goods 
5961 Catalog And Mail Order Houses 
5962 Automatic Merchandising Machine Operators 
5963 Direct Selling Organizations 
5984 Liquefied Petroleum Gas Dealers 
5989 Fuel Dealers Nec 
5992 Florists 
5993 Tobacco Stores And Stands 
5994 News Dealers And Newsstands 
5995 Optical Goods Stores 
5999 Miscellaneous Retail Stores Nec 
6011 Federal Reserve Banks 
6021 National Commercial Banks 
6022 State Commercial Banks 
6061 Credit Unions Federally Chartered 
6062 Credit Unions Not Federally Chartered 
6099 Functions Related To Depository Banking Nec 
6141 Personal Credit Institutions 
6153 Short-term Business Credit 
6159 Misc. Business Credit Institutions 
6162 Mortgage Bankers And Correspondents 
6211 Security Brokers And Dealers 
6221 Commodity Contracts Brokers Dealers 
6231 Security And Commodity Exchanges 
6282 Investment Advice 
6289 Services Allied With The Exchange Of Securities Or Commodities Nec 
6311 Life Insurance 
6324 Hospital And Medical Service Plans 
6331 Fire Marine And Casualty Insurance 
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6351 Surety Insurance 
6371 Pension Health And Welfare Funds 
6399 Insurance Carriers Nec 
6411 Insurance Agents Brokers And Service 
6512 Nonresidential Building Operators 
6513 Apartment Building Operators 
6515 Mobile Home Site Operators 
6531 Real Estate Agents And Managers 
6541 Title Abstract Offices 
6552 Land Subdividers And Developers Except Cemeteries 
6553 Cemetery Subdividers And Developers 
6719 Holding Companies Nec 
6732 Educational Religious Etc. Trusts 
6733 Trusts Nec 
6792 Oil Royalty Traders 
6794 Patent Owners And Lessors 
6798 Real Estate Investment Trusts 
6799 Investors Nec 
7011 Hotels And Motels 
7021 Rooming And Boarding Houses 
7032 Sporting And Recreational Camps 
7033 Recreational Vehicle Parks And Campsites 
7200 Personal Services 
7211 Power Laundries Family And Commercial 
7212 Garment Pressing And Cleaners' Agents 
7213 Linen Supply 
7215 Coin-operated Laundries And Cleaning 
7216 Dry Cleaning Plants Except Rug 
7217 Carpet And Upholstery Cleaning 
7219 Laundry And Garment Services Nec 
7221 Photographic Studios Portrait 
7231 Beauty Shops 
7241 Barber Shops 
7251 Shoe Repair Shops And Shoeshine Parlors 
7261 Funeral Service And Crematories 
7291 Tax Return Preparation Service 
7299 Miscellaneous Personal Services Nec 
7311 Advertising Agencies 
7312 Outdoor Advertising Services 
7313 Radio TV Publisher Representatives 
7319 Advertising Nec 
7322 Adjustment And Collection Services 
7323 Credit Reporting Services 
7331 Direct Mail Advertising Services 
7334 Photocopying And Duplicating Service 
7335 Commercial Photography 
7336 Commercial Art And Graphic Design 
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7338 Secretarial And Court Reporting Services 
7342 Disinfecting And Pest Control Services 
7349 Building Maintenance Services Nec 
7352 Medical Equipment Rental And Leasing 
7353 Heavy Construction Equipment Rental And Leasing 
7359 Equipment Rental And Leasing Nec 
7361 Employment Agencies 
7363 Help Supply Services 
7371 Computer Programming Services 
7372 Computer Programming And Software 
7373 Computer Integrated Systems Design 
7374 Data Processing Services 
7375 Information Retrieval Services 
7376 Computer Facilities Management Services 
7377 Computer Rental And Leasing 
7378 Computer Maintenance And Repair 
7379 Computer Related Services Nec 
7381 Detective Guard And Armored Car Service 
7382 Security Systems Services 
7383 News Syndicates 
7384 Photofinishing Laboratories 
7389 Business Services Nec 
7513 Truck Rental And Leasing Without Drivers 
7514 Passenger Car Rental 
7515 Passenger Car Leasing 
7519 Recreation Vehicle And Trailer Rental 
7521 Automobile Parking 
7532 Top Body Upholstery Repair Shops And Paint Shops 
7533 Automotive Exhaust System Repair Shops 
7534 Tire Retreading And Repair Shops 
7536 Automotive Glass Replacement Shops 
7537 Automotive Transmission Repair Shops 
7538 General Automotive Repair Shops 
7539 Automotive Repair Shops Nec 
7542 Car Washes 
7549 Automotive Services Nec 
7622 Radio And Television Repair 
7623 Refrigeration Service And Repair 
7629 Electrical Repair Shops Nec 
7631 Watch Clock And Jewelry Repair 
7641 Reupholstery And Furniture Repair 
7692 Welding Repair 
7694 Armature Rewinding Shops 
7699 Repair Services Nec 
7812 Motion Picture And Video Tape Production 
7819 Services Allied To Motion Picture Production 
7822 Motion Picture And Video Tape Distribution 
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7832 Motion Picture Theaters Ex Drive-in 
7833 Drive-in Motion Picture Theaters 
7841 Video Tape Rental 
7911 Dance Studios Schools And Halls 
7922 Theatrical Producers And Services 
7929 Entertainers And Entertainment Groups 
7933 Bowling Centers 
7941 Professional Sports Clubs And Promoters 
7948 Racing Including Track Operation 
7991 Physical Fitness Facilities 
7992 Public Golf Courses 
7993 Coin-operated Amusement Devices 
7997 Membership Sports And Recreation Clubs 
7999 Amusement And Recreation Nec 
8011 Offices And Clinics Of Physicians 
8021 Offices And Clinics Of Dentists 
8031 Offices Of Osteopathic Physicians 
8041 Offices Of Chiropractors 
8042 Offices Of Optometrists 
8043 Offices Of Podiatrists 
8049 Offices Of Health Practitioners Nec 
8059 Nursing And Personal Care Nec 
8062 General Medical And Surgical Hospitals 
8063 Psychiatric Hospitals 
8069 Specialty Hospitals Exc Psychiatric 
8071 Medical Laboratories 
8072 Dental Laboratories 
8082 Home Health Care Services 
8093 Specialty Outpatient Facilities Nec 
8099 Health And Allied Services Nec 
8111 Legal Services 
8211 Elementary And Secondary Schools 
8221 Colleges And Universities 
8222 Junior Colleges and Technical Institutes 
8231 Libraries 
8243 Data Processing Schools 
8244 Business And Secretarial Schools 
8249 Vocational Schools Nec 
8299 Schools And Educational Services Nec 
8322 Individual And Family Social Services 
8331 Job Training and Vocational Rehabilitation Services 
8351 Child Day Care Services 
8361 Residential Care 
8399 Social Services Nec 
8412 Museums And Art Galleries 
8422 Botanical And Zoological Gardens 
8611 Business Associations 
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8621 Professional Organizations 
8631 Labor Organizations 
8641 Civic And Social Associations 
8651 Political Organizations 
8661 Religious Organizations 
8699 Membership Organizations Nec 
8711 Engineering Services 
8712 Architectural Services 
8713 Surveying Services 
8721 Accounting Auditing And Bookkeeping Services 
8731 Commercial Physical And Biological Research 
8732 Commercial Economic Sociological And Educational Research 
8733 Non Commercial Research Organizations 
8734 Testing Laboratories 
8741 Management Services 
8742 Management Consulting Services 
8743 Public Relations Services 
8748 Business Consulting Services Nec 
8811 Private Households 
8999 Services Nec 
9111 Government Of Canada 
9121 Legislative Bodies 
9211 Courts 
9212 Government Of Prince Edward Island 
9213 Government Of Nova Scotia 
9214 Government Of New Brunswick 
9221 Police Protection 
9224 Fire Protection 
9235 Government Of Ontario 
9246 Government Of Manitoba 
9247 Government Of Saskatchewan 
9248 Government Of Alberta 
9259 Government Of British Columbia 
9262 Government Of Northwest Territories 
9263 Government Of Nunavut 
9311 Public Finance, Taxation, and Monetary Policy 
9312 City Of Montréal 
9721 International Affairs 
9999 Unclassified 
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Appendix E:  Border Crossings and Customs Offices  
 
More information regarding border crossings can be obtained from the www.ccra-adrc.gc.ca 
(Memorandum D-1-1-1, Locator Code: 233B) from Canada Customs and Revenue Agency (CCRA). 
 
The following information is sourced directly from the CCRA website and provides definitions and 

xplanations of the data contained in the Border Crossings and Customs (bor) look up table:  e 
Explanation of Columns  
 
2. The detailed office information is presented in an eight-column table that follows a standardized pattern 
with some exceptions.  
 
Port No. (Column 1)  
 
3. The number in the first column of the table indicates the office number or port number as specified in 
the Accelerated Commercial Release Operations Support System (ACROSS). Offices that have a number 
in the first column and nothing in the second column are independent offices, and they do not report 
through any other office or location.  
 
4. Locations that have a number in both the first and second column are subordinate offices that 
generally process their transactions through another office. An Inland Alternate Service (IAS) site reports 
to an independent office called a hub. Subordinate offices have their number in the first column and the 
number and name of the office they report to in the second column.  
 
Note: Transactions may be processed using either number, depending on local preferences.  
 
5. Service sites such as sufferance warehouses and marinas usually do not have a distinct number. 
They process all their transactions using an independent office number.  
 
Reports to Office (Column 2)  
 
6. This column presents the number and name of the independent office through which subordinate 
offices or service sites process their transactions.  
 
Customs Office (Column 3)  
 
7. The third column contains the name, and where applicable, the address and telephone numbers of the 
office or site. Customs offices and service sites include actual staffed customs offices, airports, vessel 
clearance terminals, offices that are serviced by staff from another location, sufferance warehouses, and 
CANPASS locations. Not all locations or facilities provide all services, and some facilities may be 
restricted to certain types of traffic or classes of goods. Offices names followed by "IAS" indicate that they 
have been designated as an area that is serviced through the Inland Alternate Service program.  
 
Hierarchy of Offices and Sites  
 
8. In general, each region is divided into an individual appendix and then sub-divided into districts within 
that appendix. (Note: Southern Ontario has recently been reorganized as one region with three separate 
divisions. For formatting purposes only, this document treats each division as if it were a separate region, 
resulting in a separate appendix for Southern Ontario (Inland), Southern Ontario (Niagara/Fort Erie), and 
Southern Ontario (Windsor/St. Clair)). Wherever possible, the primary or independent offices are listed in 
numerical order with their subordinate offices and service sites listed immediately after them. As a result 
of this, some subordinate offices may initially appear to be out of numerical order. However, they are 
actually in their appropriate place under the primary or the hub through which they process their 
transactions. 
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9. Finally, a third level of sorting has been applied to the information provided in column 3. Having been 
first grouped by the independent office number and then the subordinate office numbers in columns 1 
and 2, the various offices and sites are prioritized according to the type of function or service they 
provide.  
 
10. The general categories are, in descending order:  
(a) independent office and subordinate offices; 
(b) airports; 
(c) marine facilities; 
(d) rail stations and depots; 
(e) warehouses; and 
f)(  CANPASS service sites.   

Hours of Service (Columns 4 and 5)  
 
11. The hours of service indicate the hours that have been officially designated as the times when the 
customs office is normally open for business. Locations that are listed as being open 24 hours per day, 
7 days a week may not provide all services during the entire 24-hour period. For example, some offices 
may provide full release and accounting services during the day shift, Monday to Friday, but may not 
have full accounting services available during the evenings or weekends. Clients are encouraged to verify 
hours of operation with their local offices. Requests for new or expanded services, or services outside the 
normal business hours, may be subject to cost recovery or special service charges.  
 
12. Further information about the authorized hours of service at customs offices may be obtained by 
referring to Memorandum D1-2-1, Special Services.  
 
Services (Column 6)  
 
13. The symbols shown in column 6 indicate the specific services or activities available at the customs 
office or service site. The definitions are not necessarily all-inclusive and should be used as a guide only.  
 

HWY - Land and Inland Border Office - authorized port of entry at which passenger, general public, 
or commercial highway traffic is permitted to report. Land borders include both CANADA/U.S. border 
crossing points and inland border points.  
EDI - Electronic Data Interchange - the transmission, transfer, interchange, or electronic release of 
accounting data.  
IAS - Inland Alternate Service - the provision of release services to inland locations from a hub.  
COMMERCIAL - Designated Commercial Office - offices that provide commercial service free from 
the imposition of any special service charges on a 7 day/24 hour basis.  
IMM - Immigration - an immigration officer is on site.  
NTO - Non-Terminal Office - office is not equipped with a computer communication system.  
POST - International Mail Centre - office at which the processing of international mail or the control 
of outstanding postal accounts occurs.  
AERO-INTL - International Airport - authorized customs airport of entry and exit for clearance of all 
classes of air traffic (Airport of Entry Designator Code AOE-A - see Memorandum D2-5-1, Charter 
Access to Airports).  
AERO-REG - Regional Airport - authorized customs airport of entry and exit for clearance of 
commercial air traffic carrying freight or a passenger load not exceeding the capacity limits specified 
(Airport of Entry Designator Code AOE-R or AOE-RA - see Memorandum D2-5-1).  
AERO-GEN - General Aviation Airport - authorized customs airport of entry and exit for general 
aviation air traffic, i.e., privately operated or small charter aircraft carrying no more than 
15 passengers and their baggage (Airport of Entry Designator Code AOE-X or AOE-XA - see 
Memorandum D2-5-1).  
SeaPl - Sea Plane Landing Site - authorized point of entry for sea planes.  
C-Ves - Commercial Vessel Clearing Station - locations at which commercial vessels are permitted 
to report.  
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P-Ves - Private or Non-Commercial Vessel Reporting Station - locations at which non-commercial 
vessels (pleasure crafts) are permitted to report.  
FERRY - Ferry Terminal - terminal where passengers and vehicles embark or disembark from a 
ferry.  
CSO - Cruise Ship Operations - authorized debarkation site for cruise ship passengers and crew.  
RAIL - Railway Depot - first point in Canada at which a passenger or freight train stops and 
discharges passengers or goods.  
SWH - Warehouse - highway sufferance warehouses or special bonded warehouses for perishable 
goods.  
Shop - Duty-Free Shop - a duty-free shop is located at the customs location. More specific duty-free 
shop details can be obtained from Memorandum D4-3-2, Duty Free Shop - Licensing.  
ACEEO - locations at which acting Revenue Canada enforcement officers have been authorized.  
CPO - Only the CANPASS programs are serviced at this location  
CPA - CANPASS - Private and Corporate Aircraft  
CPB - CANPASS - Private Boat  
CPL - CANPASS - Voyageur  

 
Note: All references to CANPASS programs, services, or sites refer to a CANPASS pilot project that was 
eing tested at the time this document was released.  b 

Airport or Vessel Code (Column 7)  
 
14. This column identifies the airport designator code, the passenger capacity limits per flight for 
inspection services purposes, and the station responsible for flight plans. Further information regarding 
services provided at airports can be obtained from Memorandum D3-2-1, International Air Traffic, and 
Memorandum D2-5-1. Vessel registration office numbers are also included in this section.  
 
Opposite U.S. Office (Column 8)  
 
15. The U.S. customs office is opposite the Canadian customs office.  
 
ADDITIONAL INFORMATION  
 
16. All requests for revisions should be submitted to the following address:  
 

Manager of Facilities and Services 
Operational Policy and Coordination Directorate 
Customs and Trade Administration Branch 
Revenue Canada 
15th floor 
Sir Richard Scott Building 
191 Laurier Avenue West 
Ottawa ON  K1A 0L5  
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Appendix F:  Canadian Payments Association Classification  
  
The Canadian Payments Association (CPA) developed a classification system, which divides the 
institutions belonging to the payments associations into three groups:  
 

1.  Banks  
2.  Credit Unions and Caisses Populaires  
3.  Trust Companies, Loan Companies, and Other Deposit-Taking Institutions.  

 
In conjunction with this classification system, the Financial Institution layer includes a field called 
FIN_TYPE.  The following is a listing of institution names, by their corresponding classification type, as 
they appear in the FIN_TYPE field:    
 
Banks 
  
AMEX Bank of Canada 
AMICUS Bank 
Bank of America Canada 
Bank of Canada 
Bank of China 
Bank of East Asia (Canada) 
Bank of Montreal 
Bank of Nova Scotia  
Bank of Tokyo Mitsubishi (Canada) 
Bank One NA 
Banque Laurentienne du Canada 
Banque Nationale du Canada 
BNP Paribas (Canada) 
Canadian Imperial Bank of Commerce 
Canadian Western Bank 
Capital One Bank (Canada Branch) 
Cho Hung Bank of Canada 
Citibank Canada 
Citibank, NA 
Citizens Bank of Canada 
Comerica Bank 
Credit Lyonnais Canada 
Credit Suisse First Boston Canada 
CS Alterna Bank 
CTC Bank of Canada 
Deutsche Bank (Canada) 
Dresdner Bank Canada 

Habib Canadian Bank 
HSBC Bank Canada 
ING Bank of Canada 
International Commercial Bank of Cathay 
Intesabci Canada 
JP Morgan Bank Canada 
JP Morgan Chase Bank 
Korea Exchange Bank of Canada 
Manulife Bank of Canada 
MBNA Canada Bank 
Mellon Bank Canada 
Mizuho Bank (Canada) 
National Bank of Greece (Canada) 
Paribas Bank of Canada 
Royal Bank of Canada 
Sakura Bank (Canada) 
Societe Generale (Canada) 
Sottomayor Bank Canada 
State Bank of India (Canada) 
Sumitoma Mitsui Banking Corporation of 
Canada  
Tokai Bank Canada 
Toronto-Dominion Bank, (The) 
UBS Bank Canada 
UFJ Bank Canada 
United Overseas Bank (Canada) 

  
Credit Unions and Caisses Populaires 
 

Airline (Malton Credit Union) 
Alltrans Credit Union 
L’Alliance des caisses populaires de l’Ontario  
Brunswick Credit Union Federation Ltd. 
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CBC (Toronto) Credit Union Limited 
Civil Service Co-op Credit Society 
Co-operative Credit Society of Manitoba Limited 
Communication Technologies CR UN Ltd 
Confederation des caisses populaires et d’economie Desjardins du Quebec  
Credit Union Central Alberta Ltd 
Credit Union Central of British Columbia 
Credit Union Central of Nova Scotia 
Credit Union Central of Ontario Ltd 
Credit Union Central of Saskatchewan 
Duca Community Credit Union Ltd 
Dundalk District Credit Union Ltd 
Federation des Caisses Populaires Acadiennes Limitee, La 
Federation des Caisses Populaires de l’Ontario Inc, La 
Federation des Caisses Populaires du Manitoba Inc, La 
The Fire Department Employees Credit Union Ltd 
Goderich Community Credit Union Ltd 
Latvian Credit Union Limited 
North York Community Credit Union Limited 
Ontario Civil Services Credit Union Limited 
Polysar Lambton Credit Union Limited 
St Stanislaus-St Casimir’s Polish Parishes Credit Union Limited 
 
Trust Companies, Loan Companies, and Other Deposit-Taking Institutions 

AGF Trust Company 
Alberta Treasury Branches 
B2B Trust 
B.C. Community Financial Services Corporation 
Canada Trust Company, The 
Citizens Trust Company 
Clarica Trust Company, The 
Effort Trust Company, The 
Evangeline Savings & Mortgage Co 
Family Trust Corporation 
Fuji Bank Canada 
Granville Savings & Mortgage Corp 
Home Savings and Loan Corporation 
Household Trust Company 
International Trust Company 
Investors Group Trust Co. Ltd. 
MRS Trust Company 
Mennonite Trust Ltd 

Montreal Trust Company 
Municipal Savings & Loan Corporation, The 
Municipal Trust Company, The 
National Trust Company 
Peace Hills Trust Company 
Promutuel Capital Trust Company Inc 
Province of Ontario Savings Office 
Royal Trust Company, The 
Royal Trust Corporation of Canada 
Settlers Savings and Mortgage Corp 
Sherbrooke Trust, Company 
Societe D’Epargne St Bernard, La 
Sun Life Financial Trust Inc 
TD Trust Company 
Trimark Trust 
Trust General du Canada 
Trust General Inc 
Trust La Laurentienne 
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Appendix G:  CPIC NATIONAL DIRECTORY  
 
English Abbreviations and Definitions 

 
A 

 
AB  ALBERTA 
ACC  ACCIDENT 
ACC ADMINISTRATION 

COMMUNICATIONS CENTRE 
ACIIS AUTOMATED CRIMINAL 

INTELLIGENCE 
                              INFORMATION SYSTEM 
ADMIN  ADMINISTRATION/ADMINISTRATIVE 
AE DIST  AVALON EAST DISTRICT 
AIR  AIRPORT 
AMF  AIRPORT MAIL FACILITY 
AMT  AREA MANAGEMENT TEAM 
A&P  ADMINISTRATION & PERSONNEL 
ARU  ALTERNATE RESPONSE UNIT 
ATI  ACCESS TO INFORMATION 
ATTF  AUTO THEFT TASK FORCE 
AVE  AVENUE 
 
   B 
 
BC  BRITISH COLUMBIA 
BLDG  BUILDING 
BLVD  BOULEVARD 
BNPP BERESFORD/NIGADOO/PETIT-

ROCHER/POINTE-VERTE 
BP DIST  BURIN PENINSULA DISTRICT 
BR  BRANCH 
BSG DIST BAY ST GEORGE DISTRICT 
BUR  BUREAU 
 
   C 
 
CAL  CALGARY 
CAS  CRIMINAL ANALYSIS SECTION 
C-B DIST  CLARENVILLE-BONAVISTA DISTRICT 
CBS  CUSTOMS BORDER SERVICES 
CCAPSD COMMUNITY, CONTRACT & 

ABORIGINAL POLICING SERVICES 
CCB  COMMERCIAL CRIME BRANCH 
CCIS CALGARY CRIMINAL INTELLIGENCE 

SECTION 
CCRA CANADA CUSTOMS & REVENUE 

AGENCY 
CCS   COMMERCIAL CRIME SECTION 
CDIU    CENTRAL DRUG INFORMATION UNIT 
CDN  CANADIAN 
C&E    CUSTOMS & EXCISE 
CEF  CONTAINER EXAMINATION FACILITY 
CE&T    CUSTOMS, EXCISE & TAXATION 
CFC  CANADIAN FIREARMS CENTRE 
CFDU    COMBINED FORCES DRUG UNIT 
CFSEU COMBINED FORCES SPECIAL   

ENFORCEMENT UNIT 
CHARLT'N   CHARLOTTETOWN 
CIB  CRIMINAL INVESTIGATION BRANCH 
CIC  CITIZEN & IMMIGRATION CANADA 
CID CRIMINAL INTELLIGENCE 

DIRECTORATE 
CIIU CALGARY INTEGRATED 

INTELLIGENCE UNIT 
CIR  CIRCLE 

CIS CRIME INDEX SECTION/CRIMINAL 
INVESTIGATION SECTION 

CISA CRIMINAL INTELLIGENCE SERVICE 
ALBERTA 

CISBC  CRIMINAL INTELLIGENCE SERVICE 
  BRITISH COLUMBIA 
CISC CRIMINAL INTELLIGENCE SERVICE 

CANADA 
CISM CRIMINAL INTELLIGENCE SERVICE 

MANITOBA 
CISN CRIMINAL INTELLIGENCE SERVICE 

NEWFOUNDLAND 
CISNB CRIMINAL INTELLIGENCE SERVICE 

NEW BRUNSWICK 
CISNS CRIMINAL INTELLIGENCE SERVICE 

NOVA SCOTIA 
CISO CRIMINAL INTELLIGENCE SERVICE 

ONTARIO 
CISS CRIMINAL INTELLIGENCE SERVICE 

SASKATCHEWAN 
CIU  CRIMINAL INTELLIGENCE UNIT 
CIV  CIVIL/CIVILIAN 
CL  CIVIL LITIGATION 
CLASS  CLASSIFICATION 
CLEU COORDINATED LAW ENFORCEMENT 

UNIT 
C/M  CIVILIAN MEMBER 
CNI   CRIMINAL NAME INDEX  
CO  COMMANDING OFFICER 
CO  COUNTY 
COB  CRIMINAL OPERATIONS BRANCH 
COMCENTRE COMMUNICATIONS CENTRE 
COMM  COMMUNICATIONS/COMMUNITY 
COMP  COMPARTMENT 
CON  CONTRACTS 
CONST  CONSTABULARY 
CO-ORD  COORDINATOR/COORDINATION 
CORRECT CORRECTIONAL 
CORRES  CORRESPONDENCE 
COS CRIMINAL ORGANIZATION 

/OPERATIONS SECTION                            
CPC  CANADIAN POLICE COLLEGE/ 
                               CASE PROCESSING CENTRE 
CPIC CANADIAN POLICE INFORMATION 

CENTRE 
CPO CASE PRESENTATION OFFICER 
CPR CANADIAN PACIFIC RAILWAY 
CPSIC CANADIAN POLICE SERVICES 

INFORMATION CENTRE 
CR  CRESCENT 
CRS  CRIMINAL RECORDS SYNOPSIS 
CSAB  CORRECTIONAL SERVICE ALBERTA 
CSBC CORRECTIONAL SERVICE BRITISH 

COLUMBIA 
CSC  CORRECTIONAL SERVICE CANADA 
CSIS CANADIAN SECURITY 

INTELLIGENCE SERVICE 
CSMB CORRECTIONAL SERVICE 

MANITOBA 
CSNB CORRECTIONAL SERVICE NEW 

BRUNSWICK 
CSON CORRECTIONAL SERVICE ONTARIO 
CSSK CORRECTIONAL SERVICE 

SASKATCHEWAN 
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CST  CONSTABLE 
CTR  CENTRE 
CTY  CITY 
 
   D 
 
D5  DISTRICT 
DCAS DIVISION CRIMINAL ANALYSIS 

SECTION 
DCAU DIVISION CRIMINAL ANALYTICAL 

UNIT 
DCIAS  DIVISIONAL CRIMINAL INFORMATION  

ANALYTICAL SECTION/DIVISION 
CRIME INTELLIGENCE ANALYTICAL 
SERVICE 

DEB  DRUG ENFORCEMENT BRANCH 
DEPT  DEPARTMENT 
DES  DRUG ENFORCEMENT SECTION 
DET  DETACHMENT 
DEOC DIVISION EMERGENCY OPS 

COMCENTRE 
DEU  DRUG ENFORCEMENT UNIT 
DHQ  DISTRICT HEADQUARTERS 
DIFO DRUG INTELLIGENCE & FIELD 

OPERATIONS 
DIR  DIRECTOR/DIRECTORATE 
DIST  DISTRICT 
DIV  DIVISION 
DL DIST  DEER LAKE DISTRICT 
DND DEPARTMENT OF NATIONAL 

DEFENCE 
DOAC DANGEROUS OFFENDERS 

APPLICATIONS CENTRE 
D&R  DETENTION & REMOVALS 
DR  DRIVE 
DSC DIRECTORATE OF SECURITY 

CLEARANCES 
DSRR DIVISIONAL STAFF RELATIONS 

REPRESENTATIVE 
 
   E 
 
E  EAST 
ECD  ECONOMIC CRIME DIRECTORATE 
ECON  ECONOMIC 
EDT'N  EDMONTON 
EDPS EXECUTIVE DIPLOMATIC 

PROTECTION 
SECTION/ELECTRONIC DATA 
PROCESSING SECTION 

EEOC EAST EUROPEAN ORGANIZED 
CRIME 

E&I  ENFORCEMENT & INVESTIGATIONS 
EIIU EDMONTON INTEGRATED 

INTELLIGENCE UNIT 
ENF/ENFORCE ENFORCEMENT 
ERM ENVIRONMENT & RESOURCE 

MANAGEMENT 
ERT  EMERGENCY RESPONSE TEAM 
ESO  ENFORCEMENT SERVICES OFFICER 
EST  ESTABLISHMENT 
ESU  ENFORCEMENT SUPPORT UNIT 
EU  ENFORCEMENT UNIT 
EXEC  EXECUTIVE 
 
   F 
 
FAC FIREARMS ACQUISITION 

CERTIFICATE 

FBI FEDERAL BUREAU OF 
INVESTIGATION 

FED  FEDERAL 
FES  FEDERAL ENFORCEMENT SECTION 
FIC FINANCIAL INSTITUTIONS 

COMMISSION 
FINGERPRT FINGERPRINT 
FINTRAC FINANCIAL TRANSACTIONS AND 

REPORTS ANALYSIS CENTRE OF 
CANADA 

FIS FORENSIC IDENTIFICATION 
SECTION 

FIU  FEDERAL INVESTIGATION UNIT 
FLR  FLOOR 
FLSD FORENSIC LAB SERVICES 

DIRECTORATE 
FNCPS FIRST NATIONS COMMUNITY 

POLICE SERVICE 
FOSS FIELD OPERATIONS SUPPORT 

SYSTEM 
FOT  FEDERAL OPERATIONS TEAM 
FPS  FINGERPRINT SECTION 
FREDT'N  FREDERICTON 
FRY  FREEWAY 
FSD  FEDERAL SERVICES DIRECTORATE 
F&SD  FINANCE & SUPPLY DIRECTORATE 
FSSB  FINANCIAL SERVICES & SUPPLY 
BRANCH 
 
   G 
 
GD  GENERAL DELIVERY 
GF-W DIST GRAND FALLS-WINDSOR DISTRICT 
GHQ  GENERAL HEADQUARTERS 
GIS  GENERAL INVESTIGATION SECTION 
GST  GOODS AND SERVICES TAX 
GTEC GREATER TORONTO 

ENFORCEMENT SECTION 
 
   H 
 
HAL  HALIFAX 
HP  HIGHWAY PATROL 
HQ  HEADQUARTERS 
HRP  HALIFAX REGIONAL POLICE 
HTS  HEIGHTS 
HV-GOOSE BAY HAPPY VALLEY-GOOSE BAY 
HWY  HIGHWAY 
 
   I 
 
IAP  INTERNATIONAL AIRPORT  
IB  INFORMATICS BRANCH 
I/C, IC  IN CHARGE 
I&C  INTELLIGENCE & CONTRABAND 
ICBC INSURANCE CORPORATION OF 

BRITISH COLUMBIA 
ICES INTERNATIONAL CUSTOMS 

ENFORCEMENT SYSTEM 
ICPB INSURANCE CRIME PREVENTION 

BUREAU 
ID  INFORMATICS DIRECTORATE 
IDENT  IDENTIFICATION 
IFB  IMMIGRATION & FEDERAL BRANCH 
IFSB INFORMATICS FIELD SUPPORT 

BRANCH 
IIEU INTEGRATED INTELLIGENCE 

ENFORCEMENT UNIT 
IIS IMMIGRATION INVESTIGATIVE 

SERVICE 
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I&ISD INFORMATION & IDENTIFICATION 
SERVICES DIRECTORATE 

IJIS INTEGRATED JUSTICE 
INFORMATION SYSTEM 

ILB  INTERNATIONAL LIAISON BRANCH 
IL&POD INTERNATIONAL LIAISON & 

PROTECTIVE 
                               OPERATIONS DIRECTORATE 
IMS INFORMATION MANAGEMENT 

SECTION 
IMU  INFORMATION MANAGEMENT UNIT 
INFO  INFORMATION/INFORMATICS 
INSET INTEGRATED NATIONAL SECURITY 

ENFORCEMENT TEAM 
INST INSTITUTES/ INSTITUTION / 

INSTITUTIONAL 
INTELL  INTELLIGENCE 
INTERN  INTERNAL 
INTERPOL INTERNATIONAL POLICE 
INT'L  INTERNATIONAL 
INVEST  INVESTIGATION/INVESTIGATIVE 
IPOC  INTEGRATED PROCEEDS OF CRIME 
IP/I&P  IMMIGRATION & PASSPORT 
IPPC INTEGRATED POLICE PLANNING 

COMMITTEE 
IPS IMMIGRATION & PASSPORT 

SECTION 
IPSO INSTITUTIONAL PREVENTIVE 

SECURITY OFFICER 
ISTB INFORMATION SYSTEM & 

TECHNOLOGY BRANCH 
IU  INVESTIGATION UNIT 
IWRC IMMIGRATION WARRANT RESPONSE 

CENTRE 
 
   J   
 
JCT  JUNCTION 
JFO  JOINT FORCES OPERATIONS 
JPST  JOINT POLICE SECURITY TEAM 
JSFU  JOINT SECURITY FRAUD UNIT 
 
   L 
 
L DIST  LABRADOR DISTRICT 
LAB  LABORATORY 
LB  LESTER B. 
LBPIAP LESTER B. PEARSON 

INTERNATIONAL AIRPORT 
LIT  LITIGATION 
LMD  LOWER MAINLAND DISTRICT  
 
   M 
 
MB  MANITOBA 
MBC  MIGRATORY BIRD CONTROL 
MCU  MAJOR CRIMES UNIT 
METRO  METROPOLITAN 
MGR  MANAGER 
MGT  MANAGEMENT 
MIIU METRO INTEGRATED INTELLIGENCE 

UNIT 
M.LEG  MAIN LEGISLATIVE 
MO  MAIN OFFICE 
MPIC MANITOBA PUBLIC INSURANCE 

CORPORATION 
MRU  MOBILE RESPONSE UNIT 
MT  MOUNT 
MTD  MOUNTED 
MTN  MOUNTAIN 

MTRL  MONTRÈAL 
MUN  MUNICIPAL 
MVB  MOTOR VEHICLES BRANCH 
 
   N 
 
N  NORTH 
NAT'L  NATIONAL 
NB  NEW BRUNSWICK 
NCIB NATIONAL CRIME INTELLIGENCE 

BRANCH 
NCIC NATIONAL CRIME INFORMATION 

CENTER 
NCIS NATIONAL CRIME INTELLIGENCE 

SECTION 
NCM  NON-COMMISSIONED MEMBER 
NCO  NON-COMMISSIONED OFFICER 
NE  NORTH EAST 
NEN  NORTH EAST NOVA 
NF  NEWFOUNDLAND 
NHQ  NATIONAL HEADQUARTERS 
NICB NATIONAL INSURANCE CRIME 

BUREAU 
NLETS  NATIONAL LAW ENFORCEMENT 
                               TELECOMMUNICATIONS SYSTEM 
NP DIST  NORTHERN PENINSULA DISTRICT 
NS  NOVA SCOTIA 
NSI NATIONAL SECURITY INTELLIGENCE 

SERVICE 
NSIS NATIONAL SECURITY INTELLIGENCE 

SERVICE 
NSIU NATIONAL SECURITY 

INVESTIGATIONS UNIT 
NSS  NETWORK SERVICES SECTION 
NW  NORTH WEST 
NT  NORTHWEST TERRITORIES 
NU  NUNAVUT 
 
   O 
 
OC  OFFICER COMMANDING 
OCC OPERATIONAL COMMUNICATIONS 

CENTRE 
OCS ORGANIZED CRIME SECTION 
OIC,O I/C  OFFICER IN CHARGE 
OIS OPERATIONAL INFORMATION 

SYSTEMS 
ON  ONTARIO  
OP  OPERATIONAL 
OPF  ONTARIO POLICE FORCES 
OPP  ONTARIO PROVINCIAL POLICE 
OPS  OPERATIONS 
OPS.OFF. OFFSHORE SURV.   

OPERATIONS OFFICER OFFSHORE  
  SURVEILLANCE 
ORI:  ORIGINATOR NUMBER 
OSS  OPERATIONAL SUPPORT SECTION 
OTT  OTTAWA 
 
   P 
 
P.A.B.  PORT-AUX-BASQUES 
PA&ID  PUBLIC AFFAIRS & INFORMATION 
                              DIRECTORATE 
PB  PRIVACY BRANCH 
PC  POSTAL CODE 
PCA  POLICE CAR ACCIDENTS 
PCI PUBLIC COMPLAINTS 

INVESTIGATIONS 
PD  POLICE DEPARTMENT 
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PDRC POST DETERMINATION REFUGEE 
CLASS 

PDS  POLICE DOG SERVICES 
PE  PRINCE EDWARD ISLAND 
PEN  PENITENTIARY 
PERS  PERSONNEL 
PEU  PARKING ENFORCEMENT UNIT  
PF  POLICE FORCE 
PIRS POLICE INFORMATION RETRIEVAL 

SYSTEM 
PK  PARK 
PI  PLACE 
PLID  PLAIN LANGUAGE IDENTIFIER 
PO  POST OFFICE 
POC  PROCEEDS OF CRIME 
POE  PORT OF ENTRY 
POL  POLICING 
PORNO  PORNOGRAPHY/PORNOGRAPHIC 
PPD PROTECTIVE POLICING 

DIRECTORATE 
PROB  PROBATION 
PROT  PROTECTION/PROTECTIVE 
PROV  PROVINCIAL 
PPS  POLICE SERVICE(S) 
PSP  POLICE SUPPORT PROGRAMS 
PSU  PERSONNEL SECURITY UNIT 
PVT  PRIVATE 
P-W DIST PLACENTIA-WHITBOURNE DISTRICT 
 
   Q 
 
QC  QUEBEC (CITY/PROVINCE) 
 
   R 
 
RCMP ROYAL CANADIAN MOUNTED 

POLICE 
RD  ROAD 
REC  RECORDS 
RECNST  RECONSTRUCTION 
REG  REGION/REGIONAL 
REGISTR  REGISTRATION/REGISTRY 
REL  RELATIONS 
RHQ  REGIONAL HEADQUARTERS 
RIIU REGINA INTELLIGENCE 

INTEGRATED UNIT 
RM  ROOM/RURAL MUNICIPALITY 
RMS  RECORDS MANAGEMENT SECTION 
RPC  REGIONAL PSYCHIATRIC CENTRE 
RPO  POSTAL OUTLET 
RPU  REFUGEE PROCESSING UNIT 
RR  RURAL ROUTE 
RTE  ROUTE 
 
   S 
 
S  SOUTH 
SAS  SEXUAL ASSAULT SECTION 
SCQ  SECURITY & QUALITY CONTROL 
SCS  SERIOUS CRIME SECTION 
SCU  SERIOUS CRIME UNIT/SECURITY 
                               CLEARANCE UNIT 
S/D  SUB-DIVISION 
S/DET  SUB-DETACHMENT 
SE  SOUTH EAST 
SEC  SECTION 

SECUR  SECURITY 
SERV  SERVICE(S) 
SEU  SPECIAL ENFORCEMENT UNIT 
SID  STATE IDENTIFICATION 
SIS  SPECIAL INVESTIGATION SECTION 
SIU  SPECIAL INVESTIGATION UNIT 
SK  SASKATCHEWAN 
S/O  SUB-OFFICE 
SP'L  SPECIAL 
SQC  SECURITY & QUALITY CONTROL 
SQUAD  SQUADRON 
SR. RES OFFICER SENIOR REGIONAL ENFORCEMENT 

SERVICES OFFICER 
SS  SECURITY SERVICE 
ST  STREET 
ST/STE  SAINT(E) 
STN  STATION 
SUB-REG SUB-REGISTRY 
SW  SOUTH WEST 
SYS  SYSTEM(S) 
 
   T 
 
TA  TEMPORARY ABSENCES 
TC DIST  TRINITY CONCEPTION DISTRICT 
T&D  TRAINING & DEVELOPMENT 
TECH  TECHNICAL 
TELECOM TELECOMMUNICATIONS 
TEMP  TEMPORARY 
TF  TASK FORCE 
TLBPIA TORONTO LESTER B. PEARSON 

INTERNATIONAL AIRPORT 
TOD TECHNICAL OPERATIONS 

DIRECTORATE 
TOR  TORONTO 
TOSS TECHNICAL OPERATIONS SUPPORT 

SYSTEM 
TPOF TECHNICAL AND PROTECTIVE 

OPERATIONS FACILITY  
TSO  TAXATION SERVICE OFFICE 
TWP  TOWNSHIP 
 
   V 
 
VANC  VANCOUVER 
VCAS  VIOLENT CRIME ANALYSIS SECTION 
VICLAS VIOLENT CRIME LINKAGE ANALYSIS 

SYSTEM 
VIIU VANCOUVER INTEGRATED 

INTELLIGENCE UNIT 
VIN VEHICLE IDENTIFICATION NUMBER 
VIP  VERY IMPORTANT PERSONS 
VS  VICTIMS' SERVICES 
 
   W 
 
W  WEST 
WARR  WARRANT(S) 
WE&EI WILDLIFE ENFORCEMENT AND 

ENVIRONMENT INTELLIGENCE 
WL&AP WATER, LAND & AIR PROTECTION 
WPG  WINNIPEG 
 
   Y 
 
YT  YUKON TERRITORY 
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French Abréviations et Équivalents 
 

               A 
 
AB  ALBERTA 
AC  AGENT DE LIAISON 
ACT  ACTIVITÉ 
AD&I  ACCISE, DOUANES ET IMPÔT 
ADM  ADMINISTRATION/ADMINISTRATIVE 
ADRC AGENCE DES DOUANES & DU REVENU DU CANADA 
APPL  APPLICATION 
AT  ABSENCES TEMPORARIES 
AV  AVENUE 
 
   B 
 
BC  COLOMBIE-BRITANNIQUE 
BCS  BUREAU CONTRÔLE DES SOURCES 
BL  BUREAU DE LIAISON 
BDNC BANQUE NATIONAL DES DONNEES CRIMINELLES 
BOUL  BOULEVARD 
BR  BUREAU REGIONAL 
BRQCO BUREAU DE RECHERCHES DU QUÉBEC SUR LE CRIME ORGANIZE 
BST BUREAU SERVIENCE DE TERRITOIRE 
BUR  BUREAU 
 
   C 
 
CAAF CERTIFICATE D'ACQUISITION D'ARME À FEU 
CAF CONTROLEUR DES ARMES A FEU 
CANT  CANTON 
CDT S.-DIV. COMMANDANT SOUS-DIVISIONNAIRE 
CE  CONTRÔLE DES EFFETS 
CH  CHEMIN 
CIC CITOYENNETÉ ET IMMIGRATION CANADA 
CIPC CENTRE D'INFORMATION DE LA POLICE CANADIENNE 
CISCP CENTRE D'INFORMATION DES SERVICES CANADIENS DE POLICE 
CIV  CIVIL(E) 
CJS CASIERS JUDICIARIES SYNOPTIQUES 
CO  CENTRED'OPERATION 
COMM  COMMUNAUTE/ 
  COMMUNICATIONS/COMMUTATION 
CONTR  CONTROLE 
CONURB  CONURBATION 
COORD  COORDINATION/COORDONNATEUR 
CP  CASIER POSTAL 
CQ  CONTROLE QUALITE 
CR  CRIMINEL(LES) 
CRIM  CRIMINEL(LES) 
CRPQ CENTRE DE RENSEIGNEMENTS POLICIERS DU QUEBEC 
CRU  CENTRE RENVOIS UNIFIE 
CSSP CENTRE SERVICE EN SECURITE PUBLIQUE 
CTE  COMTE 
CTR  CENTER 
 
   D 
 
D-5  DISTRICT 5 
DA  COUANES ET ACCISE 
DC  DELITS COMMERCIAUX 
DEC  DIVISION DES ENQUETES 
DEV  DEVELOPPEMENT 
DG  DIRECTION GENERALE 
DIR  DIRECTION 
DIST  DISTRICT 
DIV  DIVISION(NAIRE) 
DSTEC DIVISION SOUTIEN TECHNIQUE ENQUETES CRIMINELLS 
 
   E 
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E  EST 
EC  ENQUETES CRIMINEL (LES) 
ECM  ESCOUADE CRIMINAL MAJEURS  
EC/ST ENQUETES CRIMINEL(LES) /SUPPORT TECHNIQUE 
ECO  ESCOUADE CRIME ORGANISE 
EF  ENQUETES FRONTALIERES 
EG  ENQUETES GENERALES 
ENQ  ENQUETES 
ERAM ESCOUDE REGIONALE ALCOOL ET MORALITE 
ERM ESCOUADE REGIONALE DES MOEURS 
ES ENQUETES SPECIALES /SPECIALISEES 
ESS  ENQUETES SPECIAL SECURITE 
ETAB  ETABLISSEMENT 
 
   F 
 
FED  FEDERAL(ES) 
FIN  FINANCIER/FINANCIERES 
FJN  FICHIER JUDICIAIRE NOMINATIF 
 
   G 
 
GCI GROUPE DE CONTROLE ET DE L’INFORMATION 
GEN  GENERAL (E) 
GOUVERN GOUVERNEMENT 
GPC GROUPE DES PRODUITS DE LA CRIMINALITE 
GQG  GRAND QUARTIER GENERAL 
GRC  GENDARMERIE ROYALE DU CANADA 
 
   H 
 
HUM  HUMAINES 
 
   I 
 
ICJ INFORMATION DES CASIERS JUDICIAIRES 
ID  IDENTITE 
IND:  INDICATIF 
INFO  INFORMATION/INFORMATIQUE/ 

INFORMATISES 
INT'L  INTERNATIONALE 
IP  IMMIGRATION ET PASSEPORT 
IRC  INTERVENTION REGION CENTRE 
 
   J 
 
JUD  JUDICIAIRE 
 
   L 
 
LOC  LOCAL 
 
   M 
 
M/MON  MONITEUR 
MAT  MATERIEL 
MB  MANITOBA 
MDN MINISTERE DE LA DEFENSE NATIONALE 
MGR  MONSEIGNEUR 
MIG  MIGRATION 
MLLL MONTREAL, LAVAL, LAURENTIDES & LANAUDIER 
MRC MUNICIPALITE REGIONALE DE COMPTE 
MSI MONITEUR SYSTEMES INFORMATISES 
MT  MONT 
MTRL  MONTREAL 
MUN  MUNICIPAL 
 
   N 
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N  NORD 
NAT'L  NATIONAL(E) 
NB  NOUVEAU-BRUNSWICK 
NE  NORD-EST 
NF  TERRE-NEUVE 
NIV NUMEROS D'IDENTIFICATION DE VEHICULES 
NOR  NORANDA 
NOUV  NOUVEAU 
NS  NOUVELLE-ECOSSE 
NT  TERRITOIRES DU NORD-OUEST 
NU  NUNAVUT 
 
   O 
 
O  OUEST 
OFF.  OFFICIER 
OFF.DIV.  OFFICIER DIVISIONNAIRE 
OFF. RESP. OFFICIER RESPONSIBLE 
OIX  OISEAUX 
ON  ONTARIO 
OP/OPER OPERATIONNEL (LES) 
 
   P 
 
PC  PRODUITS DE LA CRIMINALITE 
PDQ  POSTE DE QUARTIER 
PE  ILE-DU-PRINCE EDOUARD 
POL  POLICERES 
PR  PATROUILLE ROUTIERE 
PROM  PROMENADE 
PROT  PROTECTION 
 
   Q 
 
QC  QUEBEC (VILLE OU PROVINCE) 
QG  QUARTIER GENERAL 
QGD/QG   QUARTIER GENERAL DE DISTRICT 
DISTRICT 
QU/QUAL QUALITE 
 
 
   R 
 
RACJ  REGIE ALCOOL COURSES ET JEUX 
RC  RENSEIGNEMENTS CRIMINALS 
REG  REGION/REGIONAL(E) 
REL  RELATIONS 
RENS  RENSEIGNEMENT(S) 
REPRESS REPRESSION 
RESP  RESPONSABLE 
RESS  RESSOURCES 
ROUT  ROUTIER/ROUTIERE 
RS  RENSEIGNEMENTS SECURITE 
RSO RAPPORTS STATISTIQUES SUR LES OPERATIONS 
RTE  ROUTE 
 
   S 
 
S  SUD 
SAAQ SOCIETE ASSURANCE AUTOMOBILE QUEBEC 
SARC SYSTEME AUTOMATISE DES RENSEIGNEMENTS CRIMINELS 
SAU SERVICES AUX USAGERS 
SCC  SERVICE CORRECTIONNEL CANADA 
SCQ SERVICE CORRECTIONAL DU QUEBEC 
SCRS SERVICE CANADIEN DU RENSEIGNEMENT+DE SECURITE 
SD  SERVICE DIVISIONNAIRE 
S-D  SOUS-DIVISION 
SDAIC SERVICE DIVISIONNAIRE DES ANALYSES DES INFORMATIONS CRIMINELLES 
SDC SECTION DES DELITS COMMERCIAUX 
SDEC SERVICE DIVISIONNAIRE DES ENQUETES 
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  CRIMINELLES 
S-DIC SOUS-DIRECTION DES INFRACTIONS 
  COMMERCIALES 
S.-DIV.  SOUS-DIVISION 
S.-DON/ 
S.-DIRECTION   SOUS DIRECTION 
SDRC SERVICE DIVISIONNAIRE RENSEIGNEMENTS CRIMINELS 
SEC  SECURITE 
SECT  SECTION 
SEEA SECTION ENQUETES ECONOMIQUES 
  ANTIDROGUE 
SEF SECTION ENQUETES FRONTALIERES 
SEG  SECTION ENQUETES GENERALES 
SELF SECTION ENQUETES LOIS FEDERALES 
SEM  SEMAINE 
SENS  SENSIBILISATION 
SERV  SERVICE(S) 
SESN SECTION ENQUETES RELATIVES A LA SECURITE NATIONALE 
SESS SERVICE ENQUETES SPECIALE SECURITE 
SFD  SERVICE FRONTALIER DES DOUANES 
SFJ  SECTION DU FICHIER/JUDICIAIRE 
SLAD  SECTION LUTTE ANTIDROGUE 
SM  SURETE MUNICIPAL DU QUEBEC 
S.OFF. RESP   SOUS-OFFICIER RESPONSABLE 
SP  SERVICE DE POLICE 
SPC  SECTION POLICE CRIMINELLE 
SPCUM SERVICE DE POLICE DE LA COMMUNAUTE 
  URBAINE DE MONTREAL 
SPEC  SPECIAL(E) 
SPPCAD  SECTION DE LA PROTECTION DES  

PERSONNALITES CANADIEN ET AGENTS DIPLOMATIQUES 
SPVM SERVICE DE POLICE DE LA VILLE DE MONTREAL 
SQ  SURETE DU QUEBEC 
SRAC SECTION RENSEIGNEMENTS ET ANALYSES CRIMINALS 
SRC SECTION/SERVICE DES RENSEIGNEMENTS CRIMINELLES 
SRCMD SECTION DES RENSEIGNEMENTS CRIMINELS MORALITE ET DROGUE 
SRCQ SERVICE DES RENSEIGNEMENTS CRIMINELLES DU QUEBEC 
SRR SYSTEME DE RAPPORTS DE POLICE 
SR/TR SECURITE ROUTIERE ET TRANSPORT ROUTIER 
SS SERVICE DE SECURITE 
SSID SECTION SECURITE INTEGRATION DES DONNEES 
SSR SECTION DES SERVICES DU RESEAU 
ST/STE SAINT(E) 
STO STATION DE TRANSMISSIONS OPERATIONNELLES 
SUCC SUCCURSALE 
SUPP SUPPORT 
SUR SURETE 
SURV SURVEILLANCE 
SYST SYSTEME(S) 
 
   T  
 
TECHN  TECHNIQUE 
TELECOMM TELECOMMUNICATIONS  
TEMIS  TEMISCAMINGUE 
TERR  TERRITOIRE 
TRAF  TRAFIQUANTS 
TRANSM  TRANSMISSION 
TRANSP  TRANSPORT 
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 U 
 
ULF  UNITE DES LOIS FEDERALES 
URC UNITE RENSEIGNEMENTS CRIMINELS 
URCOMM UNITE RELATIONS COMMUNATAIRE 
URS UNITE RENSEIGNEMENTS SECURITE 
USR  UNITE SECURITE ROUTIERE 
USRTR UNITE SECURITE ROUTIERE ET TRANSPORT ROUTIER 
USTEC UNITE SOUTIEN TECHNIQUE ENQUETES CRIMINELS 
 
   V 
 
VERIF.  VERIFICATION 
 
 

Y 
 
YT  YUKON 
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Appendix H:  ISO 19115:2003 Compliant Metadata  
 
 

Metadata Notification 
 
As of May 15th 2005, DMTI Spatial data products have metadata that are IS0 19115:2003 compliant.  
 
This product now includes structured metadata files as provided in XML and/or HTM format. These metadata files 
reside with the graphic or database files to which they are associated. It is recommended that users review and 
customize the metadata as per their specific needs. 
 
This latest addition to the CanMap® line of products is another enhancement that will benefit our users and 
increase overall product satisfaction. 
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About DMTI Spatial Inc 
DMTI Spatial (DMTI) has been providing industry leading location intelligence 

solutions for more than a decade to Global 2000 companies and government 

agencies. DMTI’s world-class Location Hub™ platform uniquely identifies, 

validates and maintains a universe of location-based data. DMTI is the creator of 

the CanMap suite of geospatial data products, including CanMap® Streets and 

RouteLogistics, the gold standard for location data in Canada. DMTI also provides 

professional services and software tools bringing full solutions to the marketplace. 

Contacting DMTI Spatial Inc. 
625 Cochrane Drive Phone: 1-877-477-3684 
Markham, Ontario  info@dmtispatial.com 
L3R 9R9  www.dmtispatial.com 
Canada 
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